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Legal notices 

© Copyright 2008-2023 HP Development Company, L.P. 
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Introduction to the dispenser  

How the dispenser works 

The dispenser provides fast and reliable dispensing performance across a large dynamic range, eliminating the 
need for slow, error-prone and wasteful serial dilutions. The dispenser also enables assay miniaturization 
through low-volume assay component addition.  

The dispenser provides dispensing across a wide range of life science applications:  

• Dose-response curves for small molecule and biological-based drug discovery research 

• Drug-drug synergy experiments for drug discovery 

• Low-volume assay component dispensing of a wide range of fluids into microplates  

• Complex enzyme kinetic studies can be made simple using the Enzyme Profile function 

• Microplate PCR setups are easily designed and dispensed using the PCR function 

• DMPK standards 

• Single cell isolation 

• Single cell proteomics, genomics, and transcriptomics 

• Cell line development 

Using single-use dispense heads to help avoid the possibility of cross-contamination, the dispenser offers non-
contact digital dispensing in the picoliter to microliter range. It combines walk up convenience, ready-to-run 
performance and flexible, intuitive experiment design software to increase research productivity, reliability of 
results and the speed of life science research including single cell isolation. 

Even the most complex experimental plate layouts, such as drug-drug interaction (synergy) studies, can be 
made simple. Titrating one drug down the plate while another is titrated orthogonally across the plate enables 
two or more drug doses to be independently generated in every well. In addition, plate layouts can be 
randomized to reduce the impact of edge effects, increasing the integrity of the experimental data. The 
dispenser offers a convenient solution to address the most challenging experiments. 

Advantages of the dispenser 

The dispenser adds breakthrough capability to life science research workflows by dispensing picoliter droplets 
directly into assay-ready plates.    

Dispenser advantages 

• Elimination of Serial Dilution: Directly and independently dispense doses in each well using the proper 
number of picoliter droplets. Use finely spaced sets of doses to improve dose response curve fits.  
Digitally randomize plate layouts to reduce edge effects and increase data integrity. 

• Resource Savings: Save labor by eliminating serial dilutions. Save 90% of your precious compounds.  Save 
numerous pipette tips and intermediate plates to reduce your waste stream. Avoid ergonomic injuries and 
rework associated with repetitive hand pipetting processes. 

• Ease of Use: Enjoy a simple, intuitive user experience with quick do-it-yourself experiment design 
software. Boost productivity with walk-up, just-in-time bench top convenience. Avoid carry-over and 
washing with single use, non-contact dispensing supplies. Add all low-volume assay components with one 
system. 

• Single cell research workflow solution: Simple isolation of single cells ranging from 10-25 µm coupled 
with reagent dispensing in up to 384-well plates enables comprehensive workflow for single cell research. 
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Safety 

The dispenser should be used in accordance with all applicable safety rules that are in effect in the lab in which 
it is installed. Usage of the dispenser should also follow common-sense safety guidelines for chemical, 
mechanical, and electrical safety. 

 

NOTE: If this unit requires servicing, or you are unsure about any aspect of operation or safety, 
contact the Service Help Desk. The contact information can be found in the dispenser Service and 
Support document by navigating to the  File → Documentation menu of the software. 

 

 
CAUTION: Do not remove any of the dispenser covers. Contact your Service Help Desk if the 
dispenser is not working properly. Do not attempt to repair the dispenser yourself. 

General safety rules 

• Place the dispenser on a work surface that supports all four feet securely.  

• Plug the dispenser into a standard, grounded, electrical outlet.  Note the power requirement listed on the 
back label of the dispenser. 

• Avoid the moving parts of the dispenser during operation. 

Personal protective equipment 

The dispenser dispenses chemicals normally used by your company. The same safety precautions and personal 
protective equipment (PPE) specified by your employer for fluid transfer operations, such as pipetting into bio-
assay well plates, should be used when operating the dispenser and handling these materials. 

Possible inhalation hazard 

The dispenser was designed with chemical safety in mind; however, it does dispense picoliter droplets of fluid 
and generates a small amount, less than 1% by volume, of very small aerosol droplets that might not be 
trapped within the well plate that you are dispensing into. If the fluids are known or suspected to be an 
inhalation or contact hazard, consider using the dispenser in an exhausted enclosure such as a lab fume hood, 
or a Class 1 or 2 biosafety cabinet. 

Ergonomic safety 

The dispenser typically requires a single manual pipetting operation for each dispensed compound. In most 
situations, using the dispenser in the intended manner decreases the frequency of shoulder, arm, and wrist 
motions and so decreases the stress on these joints compared to traditional methods. 

As with any work task, workstation setup is important. To minimize ergonomic risks associated with the use of 
the dispenser, consider the following work area design ideas: 

• Place the dispenser on a work bench at a height that allows for proper visual and physical access for 
operators. Having the dispenser too high can lead to greater shoulder elevation when pipetting into the 
dispense head and having the dispenser too low can lead to increased neck and back flexion. 

• If an operator is too short to comfortably access the dispenser, consider moving the dispenser to a lower 
bench height. Alternatively, use a footstool or high lab stool that adjusts to the proper work height. 

• Place the dispenser close to the front of the work surface to minimize the distance the operator must 
reach to pipette into the dispense head. 

• Place the pipette tip disposal receptacle close to the dispenser.  
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• Place the computer keyboard close to the dispenser to minimize reach distance. 

• Adjust the computer monitor height and screen angle for good physical and visual access during dispenser 
operation. 

• Perform data analysis at a separate ergonomically designed workstation whenever possible rather than at 
the dispenser computer. 

Additional assistance 

Contact the Service Help Desk for additional assistance. The contact information can be found in the dispenser 
Service and Support document by navigating to the  File → Documentation menu of the software. 
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System specifications 

Intended use 

The dispenser and dispense heads are intended only for the following, wherein all conditions must be met:  

• Dispensing of DMSO solvent or water containing surfactant with or without small molecule compounds or 
biomolecule(s). 

• Dispensing of aqueous fluids without the need for surfactant with or without small molecule compounds 
or biomolecule(s). 

• Dispensing of single cells ranging in size from 10-25 µm 

• For research use only. 

• Single-usage (i.e., non-reusable) operation of a dispense head. 

In addition to the requirement of Intended Use, the products should not be used for any of the following: (a) 
applications in Bio Safety Level 3 or 4 (BSL-3 or-4), food, animal or human testing or therapeutic delivery 
(except solely for therapeutic delivery for in vitro research uses) (b) to dispense any of: bacteria, viruses, 
pathogens, contagions, infectious agents, potent toxins or oncogenes, radioactive substances; and (c) in uses  
that are unsafe, bypassing any Product safety features, and/or disobeying any safety instruction. 

System requirements 

• Microsoft Windows 8 or greater required; Windows 10 recommended. 

• Microsoft .Net Framework 4.8 or greater required. 

• 8 GB system RAM and 256 GB drive (minimum) recommended. 

• Minimum screen resolution of 1280x720 pixels. 

• Adobe Acrobat Reader – www.adobe.com/downloads. 

Compatible fluids 

See Appendix E–Dispense specifications for details of compatible fluids. 

Additional specifications 

See the dispenser Operating Manual for more system specifications. The Operating Manual can be found by 
navigating to the  File → Documentation menu of the software. 

 

http://www.adobe.com/downloads
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Software overview 

The dispensing software lets you: 

• Design and build protocols for dispensing fluids into well plates. 

• Run the protocols on the dispenser to dispense fluids into well plates. 

A protocol is a file which describes the concentrations or volumes to be dispensed by the dispenser. You create 
protocols with the tools and functions described in this manual. 

The Main Operating Window is the first window displayed when you start the software. It gives you control over 
protocol design functionality. From the Main Operating Window, you create, set up, edit, and run your 
dispensing protocols. 

Loading an example protocol  

A good way to become familiar with the dispensing software is to load a sample protocol. Experiment with the 
features and functionality discussed in this manual at your own pace. Try some or all of these with a focus on 
the functionality that will be most applicable to your work with the dispenser.  

• Click the File drop-down in the upper left corner. Click Open to browse the default protocols folder and 
load the Example Protocol from your default protocols folder. 

 

Select the Example Protocol and then click Open. 

• The Example Protocol is then loaded into the Main Operating Window. 

 

 
TIP: To open a copy of a protocol, use Open Copy from the File menu. A copy of the selected protocol 
will be opened, with a unique file name. 
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Main operating window - layout 

Below is an illustration of the main operating window with a loaded example protocol with the functional areas 
highlighted. Descriptions of the functional areas follow below. 

 

1. File Menu: Allows you to perform file operations common to Windows-based software (New, Save, Open, 
Exit, etc.) and to adjust system-wide settings. 

2. Ribbon and Tabs:  

The Main Operating Window ribbon, located across the top of the window, organizes commonly used 
tools and functions under three tabs. Access the functions associated with a tab by clicking one of the 
tabs: 

Home: This tab has most of the basic tools and functions necessary for building a protocol, including 
undo, copy and paste, and plate viewing, and provides easy access to all the different ways to program 
the desired titrations. 

Advanced: The functions on this tab are related to manipulating the fluids table with copy and paste, well 
lock, manipulating well plates, and device utilities. 

Current Protocol: The functions on this tab are specific to the current protocol being worked on. This tab 
holds functions for setting the desired concentration or volume units and specifying plate shaking 
parameters for mixing. 

In all tabs, some functions may be “grayed-out” (unavailable) depending on the current items (wells, well 
plates, fluids, protocol) you are working on. This is the case for functions which require selection prior to 

1. 2. 

3. 

4. 

5. 

6. 

7. 
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performing the action. The tools and functions available on the tabs are detailed in subsequent chapters 
of this manual. Most ribbon functions can also be accessed from “right-click” contextual menus. 

3. Fluid List: The Fluid List contains the fluids you have added to the protocol. The Fluid List indicates the 
fluid name and total volume of the fluid used in the entire protocol. Icons indicate whether the fluid is 
dispensed by concentration or volume and whether the fluid will be dispensed when the protocol is run. If 
the mouse is moved over a fluid, more information is displayed. 

You can add to, change, or delete from this list (see Fluid list section for details). 

4. Normalization: When a plate has been normalized (see Normalize section), this display is an indicator that 
a normalization scheme is part of this protocol. 

When the mouse is moved over the  icon, normalization information is 
displayed, including the volume of all normalization fluids used in the 
protocol and the desired dispense order for normalization fluids. 

5. Show: The Plate View area of the Main Operating Window permits turning on or off viewing of 
normalization and randomization, if those have been applied to the current protocol. Additionally, moving 

the mouse over the  icon allows you to filter the set of fluids displayed on the plate. See Show section 
for details.  

6. Plate Navigation: The Plate Navigation area allows you to add well plates to the current protocol and to 
navigate through each of the well plates in a multi-plate protocol. This area also allows you to zoom in or 
out of the well plate grid. See Multi-plate protocols and plate navigation section for details.  

7. Well plate grid: The Main Operating Window contains graphical depictions of the well plates in the current 
protocol. Each gridded area represents a single well plate, and each square represents a well. The grid 
has well rows alphabetized on the Y-axis and well columns numbered along the X-axis. The software 
identifies wells in each plate by a row-column designation – A21, B14, C16, etc. 

Information about each plate is displayed just above each plate graphic. You can change the plate 
settings by double-clicking the information area or selecting Edit Plate from the right-click context menu. 
A “Don’t dispense” droplet icon is used to skip a plate during a protocol run. See Plate-associated 
information section for details. 

The well plate receives the fluids that are dispensed by the dispenser. Based on the currently loaded 
protocol, each well is color-coded to indicate the fluid(s), as well as 
their respective concentration or volume – as indicated by the color 
saturation – in that well.  

When you move your pointing device over a well, information about 
the content of that well is displayed, including the concentration and 
volume of each fluid to be added to the well, and including 
normalization fluids if applicable. 

Since fluid is dispensed in increments of dispense head drops, for low 
volumes the well content information will display both requested and 
dispensed concentrations and volumes. The first 
concentration/volume is the requested concentration or volume. The actual concentration and volume is 
shown in brackets. 

See Appendix D–Concentration calculations for more detail about concentration calculations. 

 

 

NOTE:  In some instances, the concentration/volume you program into a well will not be in the 
range of the dispenser’s capability (see Appendix D–Concentration calculations). In such cases, the 
well contents will display a warning message such as “Below minimum dispense volume.” 
Additionally, the report file will show only the concentration/volume actually dispensed. 
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Building a simple protocol 

Creating a new protocol file 

You can create a new protocol in one of two ways: 

Via the initial main operating window 

The following procedure will create a new protocol: 

• Start the dispensing software. 

• The initial “empty” Main Operating Window is displayed.  

• Work on that empty protocol, then save your work and name the protocol. 

Via the File menu 

When the software is running, create a new protocol as follows: 

• In the File Menu, click New. 

 

 

A new protocol is created using the default protocol settings. 

 

Fluid list 

The Fluid List, located on the left side of the Main Operating Window, is the place to define all the fluids that can 
be used in a protocol. Each fluid must be given a unique name, and the fluid concentration (stock concentration) 
must be identified. Setting up the Fluid List is one of the first steps in creating a protocol. 

In a new protocol, the Fluid List is empty. Note that you can copy a list of fluids from another protocol using the 
Copy/Paste Fluids from the fluid list function discussed later in this manual. You can also build the Fluid List 
from scratch. 
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Show more information 

For each fluid, information is displayed in the list, with more detail shown when the mouse is moved over a 
fluid. To show more information for each fluid, right-click on the list and select Show More from the menu. You 
can also change the default fluid view from the Display section of Settings. 

 

  

Fluid dispense mode 

Each fluid is specified to be dispensed by concentration or by volume.  

When dispensed by Concentration, the software uses the fluid stock concentration and total well volume to 
calculate what volume of the fluid is needed to achieve the desired concentration. The software maintains the 
programmed concentration in the well if other parameters, such as assay volume or stock concentration, are 
changed.  

When dispensed by Volume, the software maintains the programmed volume in the well if other parameters 
are changed. If the stock concentration of a fluid is unknown, it must be dispensed by volume; the stock 
concentration may be left unspecified. If you adjust the stock concentration of a fluid dispensed by volume, the 
resulting concentration in the programmed wells will be adjusted because the dispensed volume will be 
maintained. 

Adding a fluid 

The figure below shows an empty Fluid List. To add a fluid to the list, click the plus sign (+) to the right of the 
Fluids heading. Note that the fluid group, fluid class, concentration, and dispense by concentration/volume 
default to the values specified in Settings.  You can change the default settings. 

 

 

 

A preliminary entry is created that can be used as is or modified if desired. To modify any of the parameters, 

click the  button; you can now Edit the entry of any fluid. You can also Edit the entry by double clicking. 

 

 

 

 

 

 



 

 Dispensing Software 14 

 

 

An example Fluid List is shown below. 

 

For each fluid, the name and total volume of the fluid used in the entire protocol is shown. 

 

 
NOTE: If the total dispense volume of a fluid exceeds the maximum dispense volume (see Appendix 
E–Dispense specifications), the volume will be split between two or more dispense heads.  

 

Icons indicate whether the fluid is dispensed by concentration or volume and whether the fluid will 
be dispensed when the protocol is run. When the mouse is moved over a fluid the fluid class, stock 
concentration and other information are shown. 

Editing fluids 

Click  to bring up the Fluid Edit dialog box. To edit a fluid, click on the fluid in the list.  

You can also add a new fluid by clicking  just as you can do from the main fluid list. Note that this method 
also copies the concentration, fluid class, dispense mode and source plate from the current fluid to the new 
fluid.  
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If desired, provide the fluid a different name and edit the stock concentration, dispense mode, or specify a 
different fluid group and fluid class. 

The fluid group is used to adjust dispense characteristics for different types of fluids. In addition to DMSO fluids, 
there are additional classes based on aqueous fluids, acetonitrile, master mixes, and cells. Within each fluid 
group additional specifications can be defined with the fluid class selection drop down menu. Refer to Appendix 
E–Dispense specifications for fluid class details.  

 

The  button can be used to calculate a concentration, converting between units using molecular weight. 

 

 

 

NOTE: Concentration can be specified in molarity or mass/volume units, but well concentrations 
cannot be converted between unit types. If unit type is changed and the fluid is used in the protocol, 
well fluid dispense values are maintained (concentration or volume depending on the Fluid dispense 
mode). 

 

You can also fill in any or all of the following optional information as desired. This information is used in the 
fluids list and will be included in the report file: 

• Source plate   

• Source well  

• The color used to identify the fluid in the protocol can be changed 

If Dispense is set to Don’t Dispense by clicking the droplet icon next to a fluid, you can associate the fluid with 
wells like the other fluids, but it will not be dispensed. This may be useful when you want a fluid to be used in 
Normalization calculations or to track controls that will be dispensed by a method other than with the 
dispenser. 

If a fluid is changed, an Apply button will appear. You will also be prompted to save when closing the dialog box 
or selecting a different fluid to edit. 

Small molecules 

For aqueous fluids with stock concentration specified in mass units, the small molecule option is displayed. For 
this purpose, small molecules are defined as molecules under 1000 Da. 

 

 

If the source fluid is a small molecule, this option can be checked to prevent the system from applying 
biomolecule dispense limits based on stock concentration. See Dispensing considerations for more 
information. 
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Removing fluids 

Fluids can be removed from the protocol by selecting a fluid and pressing the Remove Selected button below 
the list. 

 

Rearranging fluids 

Fluids can be moved up and down the list in the fluid editor by selecting a fluid and dragging it to the desired 
location with the cursor. 

Creating diluted fluids 

Diluted fluids can be used to extend the dynamic range of the dispenser. Diluted versions of a fluid can be 
created using the Create Diluted Fluids button. Multiple dilutions can be created at the same time. 

The new fluids will be inserted into the fluid list after the original fluid. 

 

 

 

 

NOTE: If a fluid is derived from another fluid using Creating diluted fluids or as the result of a 
Fluid shift or extend, some of the information cannot be edited and may change automatically 
when the source fluid is changed. 

 

Plate parameters 

A new protocol is created with a single plate using Default values from Settings. 

See the Plate-associated information section for details on how to change the plate type or other plate 
attributes. Additional volume must be set correctly; it is the volume added to each well of the plate not using 
the dispenser and is used for concentration and normalization calculations (see Appendix D–Concentration 
calculations). 
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Well selection and de-selection 

Prior to using well tools and functions, wells must be selected in the well plate grid. 

Selecting wells via rectangle 

Select a large group of adjacent wells by dragging a rectangle.  

• Move your cursor to the desired area of the well plate grid.  

• Click the left button once and keep it pressed, then drag over the target area. Wells will be highlighted as 
you drag. 

• Once you release the left button all selected wells are shaded and outlined. 

 

  

Row/column selection 

Entire rows or columns can be selected by clicking on a row or column header to start selection. Only rows or 
columns from a single plate may be selected until the mouse button is released. 

Entire well selection 

All wells in a plate can be selected by double clicking on any well. 

Additional selection/de-selection 

Once wells have been highlighted as selected, hold down the CTRL key while clicking wells to: 

• Add unselected wells by holding the CTRL key while clicking an unselected well. 

• Remove wells from the selection by holding the CTRL key while clicking a selected well. To de-select all 
wells, just click outside the plate. 

 

Basic titration example 

 

Fluids can be added to wells in three basic ways: as a fixed concentration or volume (Set value), as an evenly 
spaced titration series (Titration), or as a targeted titration series (Targeted titration). 

The example in this section describes how to set up an evenly-spaced titration series consisting of 8-point 
triplicates using two different fluids. 
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• Select 24 wells in the well plate for titration of the first fluid. 

• On the Home tab, select Titration.  An editing panel is then displayed. 

 

 

• Select a fluid from the drop-down list. 

• Specify titration using highest and lowest concentrations. 

• Assign Highest concentration (or volume) parameter. 

• Assign Lowest concentration (or volume) parameter. 

 

• Change Replicates per level to 3 and leave the distribution and titration pattern unchanged. 

• Once you have completed your edits, click Apply. “Apply” applies the function without closing the dialog 
box, while, “Done” closes the dialog box.  

• Now, with the titration dialog box still open, select a new set of 24 wells into which to apply the second 
fluid. 

• In the titration dialog box, select a different fluid from the dialog box and click Apply. This will apply the 
second fluid to the wells with the same settings for concentration/volume as the first fluid.  

The well plate grid now shows the fluids to be titrated in the selected wells of the well plate. If the titration 
pattern is not what was intended, or the concentration/volume needs to be adjusted, simply re-select the wells 
and enter the titration dialog box again, to over-write the wells with the new parameters. 

 

TIP: Use the paste function in the lower-right area of the panel to auto-fill the highest and 
lowest concentration with the valid range limits. The high value is determined from fluid 
concentration and DMSO limit or recommended maximum aqueous dispense volume.  The 
low value is limited by minimum dispense volume. 
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Additional detail about titration can be found in the Titration section. 

Undo 

To undo an action after you perform it, click the Undo icon in the Home tab of the ribbon or use the keyboard 
shortcut (CTRL-Z). 

 

Saving the protocol file 

Make sure you save your work during and after each protocol design session. On the File Menu, click Save at 
any time to save your work. 

Note: If you are saving a protocol for the first time, a browsing window will be displayed where you can name 
and relocate the file. 

Closing the application and saving your work 

In the Main Operating Window, clicking the X closes the current protocol and exits the program. If you modified 
the protocol and haven’t saved, you are asked if you want to save the modifications. 
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TIP: Even if you have saved changes in one or more of the tools and functions described above, if you 
click Don’t Save, all of your modifications to the protocol will be discarded. 
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Additional protocol features 

The Building a simple protocol chapter detailed the basics of creating a protocol. This chapter discusses all the 
tools and functions you can use to build protocols. 

Multi-plate protocols and plate navigation 

 

 

 

The Plate Navigation area of the Main Operating Window allows you to  

• Create a protocol with more than one plate,  

• Navigate through each of the plates in a multi-plate protocol, and  

• Zoom the well plate grid. 

To add a new, empty plate to the current protocol, click the  sign. When you do this, the empty plate is 
displayed and becomes the one you are working on. 

 

The Plate N of X label indicates the current plate number you are working on (N) and the number of plates in 
the protocol (X). To navigate through multiple plates in a protocol, use the back and forward arrows on either 
side of the label. The keys “Page Up” and “Page Down” can also be used to navigate plates. 

If you are working on a multi-plate protocol, refer to this area to see which plate is the “current” plate (plate N 
of X). 

Zoom 

To zoom the well plate grid: 

• Move the bar towards zoom out   to see more real estate in the current plate and additional plates in 
the protocol. 

• Move the bar towards zoom in   to focus in on the plate wells. 

• Alternately, you can click the icons to zoom in or out by a small amount. The mouse wheel can also be 
used to zoom in or out while holding the CTRL key. 

Plate-associated information 

Plate-associated information is displayed above each plate. 
 

 

 

 
NOTE: To minimize evaporation, it is recommended that protocols using aqueous fluid classes be 
limited to 1536 wells or four plates. 
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This information can be changed by clicking  on the menu bar, double-clicking the information area, or by 
selecting Edit Plate from the right-click context menu. 

 

 

• You can Name the current plate.  Use this name as your own reference to help you determine which plate 
to load during runtime. 

• Modify the Plate type via an updated choice from the drop-down menu. 

Note that the plates in a multi-plate protocol do not need to be of the same plate type, nor do they need 
to have the same additional volume or DMSO limits.   

• Change Additional volume via manual entry. Additional volume is the volume added to each well of the 
plate not using the dispenser and is used for concentration and normalization calculations (see Appendix 
D–Concentration calculations). 

• Change DMSO limit via manual entry.  

• Click Shake plate to keep this plate from shaking even when shaking is enabled for the protocol. Don’t 
shake is always set for 1536-well plates and cannot be changed. 

• Click Dispense plate to keep this plate from being dispensed during a multi-plate run. 

The Plate Edit dialog box allows you to go directly to edit other plates without exiting by selecting a plate icon 
on the left side of the editor. 

• You can also add a new plate directly from the dialog box by clicking . Note that this method also copies 
the edit plate type, additional volume, and DMSO limit to the new plate. 

Saving/canceling your edits:  

• To save your edits, click Apply or move to another plate.  

• To cancel your edits, click Cancel. Note that this will only cancel edits to the current plate, but it will not 
cancel saved changes to previously edited plates. Once you click either of these options, the dialog box 
closes, and you are brought back to the Main Operating Window. 

Don’t dispense a plate 

At the far right of the plate-associated information is a Droplet icon that controls whether a plate is 
dispensed. 
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Click the Droplet  to initiate Don’t dispense plate to skip the current plate when running the protocol.  Note 
that this setting is temporary; it is not saved with the protocol. 

 

 

Set value 

 

If you want to add fluid to wells at a single concentration/volume, as opposed to as a titration series, use the 
Set Value function. 

• Select the wells to which you wish to add the fluid. 

• On the Home tab, select Set Value. 

 

 

• Select a fluid from the drop-down and specify the concentration or volume of the fluid depending on the 
dispense mode for the fluid. Ensure that the value is within the valid range. Note that the range minimum 
is a “hard” limit based on dispenser drop size, but the upper limit is a suggestion to keep the DMSO limit or 
recommended maximum aqueous dispense volume from being exceeded. 

Once you have updated the parameters, click Apply (applies the function) and Done (closes the panel). 
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NOTE: A diluted fluid may be suggested if the requested value with the stock fluid concentration 
would be significantly below the minimum dispense volume.  See the Fluid shift or extend section for 
more information. 

 

 

NOTE: For the functions of: Set Value, Titration, and Targeted Titration: 

After you click Apply, if the fluid was previously assigned to 
any of the selected wells, you will receive a warning 
message to Replace or Cancel. If you choose Replace, the 
newly defined values will overwrite the previous values for 
that fluid in the selected wells. If different fluids were 
previously assigned to any of the selected wells, the new 
fluid will be added to, and not replace, the existing fluids.  

 

 

Titration 

 

This section describes how to set up an evenly-spaced titration series in more detail than the basic titration 
example section did. 

• Select the wells in the plate for titration. 

• On the Home tab, select Titration. An editing panel is then displayed. 

Highest and lowest concentration 

Use this selection to specify both the high and low limits for the titration and let the software fill in the 
remaining points, equally spaced according to the selected distribution. 
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• Select a Fluid from the drop-down list. 

• Assign the Highest concentration (or volume) parameter. 

• Assign the Lowest concentration (or volume) parameter. 

 

 

TIP: Use the paste function in the lower-right area of the panel to auto-fill the highest and 
lowest concentration with the valid range limits. The high value is determined from fluid 
concentration and DMSO limit or recommended maximum aqueous dispense volume. The 
low value is limited by minimum dispense volume. 

 

• Select the Distribution via the drop-down list - Logarithmic or Linear. 

• Assign Replicates per level. Each titration level will be replicated the specified number of times. The 
number of selected wells must be a multiple of Replicates. For instance, if 12 wells are selected, 3 
replicates will result in 4 levels. 

• Select the Titration pattern from the drop-down menu. The graphics illustrate where the Highest and 
Lowest levels will be placed in the selected area as well as whether the titration is distributed by row or 
column. 

Once you have completed your edits, click Apply (applies the function) then Done (closes the panel). 

 

 
NOTE: A fluid shift or extension may be suggested if the requested titration cannot be achieved with 
the stock fluid concentration specified.  See the Fluid shift or extend section for more information. 
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Highest concentration or lowest concentration 

Use this selection when you wish to specify either the highest or the lowest concentration and apply a specific 
distribution, such as a 1:4 dilution, to the remaining points. 

 

 

• Select a Fluid from the drop-down list. 

• Assign Highest concentration (or volume) parameter if you are using highest or assign Lowest 
concentration (or volume) parameter if you are using lowest. 

• Select the desired Distribution via the drop-down menu – 1/2 Log, 1/3 -Log, 1/4-Log, 1:2, 1:3, 1:4, 1:N, or 
Linear. For 1:N, N is a numerical value greater than 1 (does not need to be an integer). For Linear, the value 
increment is also specified. 

• Assign Replicates per level. Each titration level will be replicated the specified number of times. The 
number of selected wells must be a multiple of Replicates. For instance, if 12 wells are selected, 3 
replicates will result in 4 levels. 

• Select the Titration pattern from the drop-down menu. The graphics illustrate where the Highest and 
Lowest levels will be placed in the selected area as well as whether the titration is distributed by row or 
column. 

Once you have completed your edits, click Apply (applies the function) then Done (closes the panel).  
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Targeted titration 

 

In a targeted titration, the levels are not distributed evenly. The targeted titration includes a user-defined zone 
where the levels are densely spaced around a value of interest. Targeting the titration around an expected IC50 
value, for instance, can improve the IC50 estimate or make the same quality of estimate with fewer wells. 

Many of the fields required for Targeted Titration are the same as the fields for Titration. A targeted titration 
can only be programmed by specifying both the highest and lowest concentrations. The additional fields for 
targeted titration are related to specifying the target range. 

 

 

• Assign the Target concentration value – This value will become the center of the densely spaced region 
and must lie within the Highest and Lowest concentrations. This value might be, for example, the 
expected IC50. 

• Assign the number of wells in the Target region. These wells will lie on either side of the target 
concentration value.  

• Assign the +/- Target range. This defines the concentration or volume range above and below the target 
value that will be covered by the specified number of wells. 
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When the panel contains sufficient information, the diagram will indicate how many wells are planned for each 
“tail” region above and below the target region and will show where the target region falls within the overall 
titration. When calculating the targeted titration, the software will always apply one well to each end 
concentration (the highest and lowest) and then any wells remaining after being distributed to the target region 
will be evenly spaced within each tail region. 

 

Fluid shift or extend 

If the titration specified in Titration, Targeted Titration, Synergy, Quick Plate, Enzyme Profile or PCR would 
result in well volumes significantly below the minimum well dispense volume, a shifted or extended fluid will be 
suggested.  The suggested fluid will be an integral dilution of the selected fluid: 1:2 through 1:9, 1:10 through 
1:90, etc. and less than 1:10,000 dilution. 

A diluted fluid may also be suggested from Set Value, PCR, etc., if the well volume would be significantly below 
the minimum well dispense volume. 

If the diluted fluid is accepted, a new fluid will be automatically added to the fluid list and the titration will be 
completed using that fluid. In this case, you must create a new stock fluid based on the original stock fluid, 
following the recommended dilution. For a 1:20 dilution, it is expected that you will add 1 part of the original 
fluid to 19 parts diluent, to create a 5% solution of the original stock fluid. 

If the titration can be accomplished with one fluid spanning the full concentration range requested, you will be 
offered a Fluid Shift. If, however, the concentration range is greater than that which can be achieved with a 
single fluid, you will be offered a Fluid Extension and the titration will be comprised of both the original stock 
fluid and the diluted extended fluid. 

If the diluted fluid is not accepted, the titration will be completed using the original stock fluid, and the wells 
that were requested with concentrations/volumes outside the accessible range will be flagged as being below 
the minimum dispense volume. 

 

 
NOTE: Diluted fluids are permanently associated with the original stock fluid. If the original fluid is 
modified (name, concentration, etc.) the diluted fluid will also be changed. 
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Fluid shift 

For example, if the following titration is specified: 

 

 
You will be prompted to create a shifted fluid, diluted 1:4 (25%). 

 

 

This creates a new fluid and the titration will use the new fluid. 
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Fluid extend 

If the limits of the titration are modified as shown: 

 

 

The titration cannot be accomplished with a shifted fluid and an extended fluid is offered. 

 

 



 

 Dispensing Software 31 

 

This creates a new fluid and the titration will use both the original and new fluids.  If possible, the maximum 
DMSO % of the extended fluid will not exceed that of the original fluid in the titration. And, the maximum DMSO 
% of the extended fluid will never exceed that specified in the plate parameters. 

 

  

 

Normalize 

 

For some assays, it may be advantageous to normalize the DMSO or aqueous surfactant content of the wells. 
Because of the digital nature of dispensing from the dispenser, without normalization, not all wells will contain 
the same DMSO or surfactant content. It may also be desired to normalize the total volume of all fluids in a 
well, regardless of fluid class. 

It is typical for the DMSO content in dispensed wells to range from 0.00001%-1%. For many assays it is 
preferred to minimize the DMSO content, but for others, normalizing the DMSO content to the highest level or 
some intermediate level may be desired. 

It may also be advantageous to normalize the dispensed surfactant content for certain assays. 

 

 

TIP: The dispense range for Normalization Fluid is specified in Appendix E–Dispense specifications. 
Normalization cannot dispense a quantity lower than 1nL per well.  If normalizing a well requires 
dispensing less than 1nL of fluid, no fluid will be added to that well.  

 

• Select the wells for to be normalized with a specific fluid class. Wells may be selected from multiple 
plates. Note that Normalize is not accessible unless you have selected wells. 

• In the Home tab, select Normalize.  

• To normalize a class of fluids, select one of the available normalization options via a radio button on the 
Normalize Fluid Class tab. 
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Select the fluid class to normalize from the list. A well can be included in multiple normalization groups, 
but there can be only one group for each fluid class. 

 

 

 

Normalize to highest class volume: This will add normalization fluid to selected wells such that the 
normalization fluid + titration fluid volumes all equal the highest volume well in the selection. It will not 
add normalization fluid to the highest volume well. 

Normalize to specified volume: This will add normalization fluid to selected wells so that the 
normalization fluid + titration fluid volume is equal to the specified volume, unless the titration fluid 
volume already equals or exceeds the specified volume, in which case no normalization fluid will be 
added. 

Normalize to specified % of total volume: This will add normalization fluid to selected wells such that the 
normalization fluid + titration fluids all equal the specified % of total well volume. It will not add 
normalization fluid to wells that contain titration fluid equal to or in excess of the specified % of total 
volume. 

 

 
NOTE: If normalizing to % of total volume, each well is normalized to the volume appropriate for the 
well. This includes additional volume that may be different for each plate in the normalization group. 

 

• To normalize the total volume of a well – all fluids regardless of fluid class, and including Additional 
volume (see Plate-associated information) – select one of the normalization options on the Normalize 
Total Volume tab. 

The fluid class to use for normalization must be selected. A well can be included in multiple normalization 
groups, but there can be only one group for each fluid class. 
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Normalize to highest fluid volume: This will add normalization fluid to selected wells such that the 
normalization fluid + titration fluids + additional volume equals the highest total volume well in the 
selection. It will not add normalization fluid to the highest total volume well. 

Normalize to specified volume: This will add normalization fluid to selected wells so that the 
normalization fluid + titration fluids + additional volume is equal to the specified volume, unless the 
additional volume + titration fluid volumes already equals or exceeds the specified volume, in which case 
no normalization fluid will be added. 

• Click Normalize to normalize the selected wells in the protocol or Cancel to abort normalization. 

 

 
TIP: Wells that are normalized together using the same options are referred to as a normalization 
group. 

 

The normalized wells are subsequently displayed with a black tick mark in the lower-left corner of the well, 
indicating well normalization.  

When you move your cursor over a normalized well, you see the normalization details in the displayed 
information: 

 

 

The Normalization display in the Main Operating Window below the Fluid list shows up if the plate has a 

normalization scheme. When the mouse is moved over the  icon, the total normalization volume for each 
fluid class is displayed. 

 

 

• Set the Dispense order for the normalization fluids. Normalization fluids can be dispensed strictly before 
or after the fluids or they can be dispensed with the fluids. 

 

 
NOTE: When dispensing a protocol using high-volume cassettes, the Dispense order may cause 
dispensing to alternate between cassette types. 

 

• The dispense icon /  allows you to not dispense all normalization fluids. 
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Show normalization 

See the Show Normalization section in Show. 

Remove normalization 

Use this function to remove from the selected wells any normalization you previously set up. If there are no 
normalized wells in the selected wells, this function is grayed-out and not accessible. 

• Select the wells from which you want to remove normalization. 

• Click Remove Normalization. This function is also available from the right-click contextual menu. 

 

 

• A dialog box is then displayed, asking you for confirmation to remove all normalization from selected 
wells. 

 

  

• Click Yes to confirm the removal of normalization or No to abort the function. If you cancel, the 
normalization is left in place (see below, left). If you give confirmation, the cells marked for normalization 
lose their tick marks, and the normalization is removed (see below, right). 

 

 

Select normalization group 

This function shows you which wells are normalized together following the same options. For instance, if you 
used “normalize to highest fluid volume” this function will show you which wells are included in this calculation. 
This is important if you specify and then later wish to view multiple separate groups that are all normalizing to 
unique highest values.  

• Select a well that is normalized. 
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• Click Select Normalization Group. 

• If the well is included in multiple normalization groups (different fluid classes), indicate which group to 
select. 

The wells that are normalized together become selected. 

 

 

Randomize 

 

Once a plate has been configured, the wells can be reordered randomly on the plate. This is a useful way to 
minimize the impact of systematic assay effects on the output data. 

 

 

NOTES: Randomization is a “per plate” feature. It is not possible to create separately randomized 
regions within a single well plate. The selected wells on the plate will be randomized. If you later wish 
to add more randomized wells to the plate, they will be added to the rest of the randomized wells 
with all randomized together as one group.  

 

• Select the wells desired for randomization. 

• Click Randomize to randomize the selected wells. 

The randomized wells are subsequently displayed with a white tick mark in the lower-right corner of the well 
indicating well randomization. In addition, when you move your cursor over a normalized well, you see the 
“Randomized” tag in the displayed information: 

 

Show plate randomization 

See the Show Randomized section in Show. Note, if you are viewing wells as randomized, some other 
functionality will be limited. Change the Show option to unselect Show Randomized to enable full control. 

Remove plate randomization 

For the current plate in a protocol, use this function to remove all randomization from the current plate. If there 
are no randomized wells in the current plate, this function is grayed-out and not accessible. 

• Click Remove Plate Randomization. 
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• A dialog box is then displayed, asking you for confirmation to remove the randomization scheme. 

 

 

• Click Yes to confirm the removal of the randomization scheme or No to abort the function. If you give 
confirmation, the cells marked for randomization lose their tick marks, and the randomization scheme is 
removed. 

 

 

Copy plate randomization 

Use this function to copy the randomization scheme from one plate to another within the same protocol.  You 
can only copy randomization to plates with the same dimensions as the source plate. 

• Click Copy Plate Randomization. 

• A dialog box is then displayed, asking you for the source plate and the target plate(s). Use the drop-down 
menu to specify source and destination. Note that you have the option to copy the randomization scheme 
from the source plate to all similar plates in the protocol. 
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• Click Copy to perform the copy or Cancel to abort it. If you perform the copy to All similar plates, all plates 
with the same dimensions as the source plate will now have the same randomization scheme. You can 
also copy to the Clipboard and paste the randomization scheme to a plate in another protocol. 

Paste plate randomization 

Use this function to paste a plate randomization scheme that was copied to the Clipboard from another plate or 
protocol. 

 

 

Copy & paste basics 

 

You can copy and paste wells to duplicate them within a plate or copy them to another plate. You can also copy 
and paste all wells to duplicate the well contents in the current protocol or move them to another protocol. 

 

 
NOTE: Pasting wells overwrites any current information in the target wells or plates. 

 

Copy Wells/Paste Wells 

• Select the desired well(s) on the plate, using the techniques discussed previously. 

• Click Copy Wells or Cut Wells on the Home tab. “Cutting wells” makes the selected wells revert to empty. 

• If the wells are being pasted into another plate, navigate to that plate to make it the current, target plate. 

• Set the Paste target by clicking the upper-left-most well of the target area.  
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• Click Paste to bring the copied wells into the target area. The pasted wells will overwrite, without warning, 
any other well contents. If there is not enough contiguous space in the target area, you will get a paste 
warning message about truncation; at that point, you can cancel the Paste or continue with the truncation. 

 

 
NOTE: All fluids and normalization are included in copy, cut, and paste. When copying to an external 
application (e.g. Excel), however, normalization is not included. 

 

Copy All Wells 

Use this function to copy all well fluid contents from one plate to another. The plate types do not need to be 
the same. If a less dense plate is copied to a higher density plate, all the wells will be copied. Conversely, if a 
higher density plate is copied to a lower density plate, the wells will be truncated, with a warning. When the 
contents of a plate are copied and pasted into another plate, all fluids and normalization are copied but 
randomization is not copied. Additionally, target plate parameters such as additional volume and DMSO limit, 
are not copied. 

• Navigate to the plate that you want to copy. 

• Click Copy All Wells. 

• Navigate to the target plate. If you want to set up a new plate with an existing one as a source, click the  
sign to create the new plate. 

• Click Paste to paste the copied wells into the target plate.  

If the target plate is not empty you will be warned before pasting.  If you choose not to replace all fluids on the 
plate, the copied fluids will be added to existing plate fluids, unless the same fluid occurred in both the source 
and target plates, in which case that fluid will be replaced. 

If there is a mismatch in the plate size being copied vs. the target plate, you will receive a warning message. At 
that point, you may cancel or continue the paste. The result may be that the wells all fit and become one 
quadrant of the new plate, or the wells will be truncated. 
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Paste Special 

Paste Special is similar to Paste, but with the option of mapping each fluid to a different fluid.  You can also 
choose not to paste individual fluids if you wish to leave selected wells of a specific fluid blank in the pasted 
region. 

 

• If the source wells include normalization, you can also choose to Paste normalization. 

• If the Replace all fluids in the paste region box is not checked, the pasted fluids will be added to fluids that 
already exist in the target plate, unless the same fluid occurred in both the source and target plates, in 
which case that fluid will be replaced. 

• It is optional to Transpose rows and columns. 

You cannot map fluids that have different unit types (molarity vs. mass/volume) or dispense modes (by 
concentration/volume). 

 

View 

 

This Home tab function is a complement to Zoom. 

• Click One Plate to size and center the current plate in view.  
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• Click All Plates to bring all plates into view. 

 

 TIP: Double-click a plate border to size and center that plate in view. 

 

 

Show 

The Show area of the Main Operating Window allows you to filter what is displayed in the Well plate. Move the 

mouse over the  icon to show the fluid filter selection list. 

 

 
 

Show Normalization 

If normalization is used in the protocol, the checkbox allows you to view or not view the normalization fluid in 
the well plate. 

Show Randomized 

If randomization is used in the protocol, the checkbox allows you to view or not view the plates randomized. 

Show Fluids 

Click and select from the drop-down menu to indicate which fluids in the protocol’s fluid list should be 
displayed on the plate. 

• All fluids 

• Dispensed fluids 

• Only the fluid selected from the list 

 

Plate functions 

 

Remove Plate 

• Navigate to the plate that you want to remove. 

• Click Remove Plate on the Advanced ribbon tab. A dialog box is displayed, asking you to confirm the 
removal or cancel it. 
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• Click Remove to remove the current plate. Click Cancel to stop the removal. 

 

Removing plates with the plate editor 

You can remove plates by selecting the  icon next to Plates. 

• The current plate is always selected. 

• You can toggle plate selection for an individual plate by selecting the icon of a given plate. 

• Plates can be removed by clicking the plate icon and clicking Remove Selected. 

 

• Confirm plate removal by selecting Remove or Cancel to go back to the plate editor. 
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Removing multiple plates 

You can remove multiple plates by holding down the CTRL key, selecting multiple plates by clicking the plate 
name (e.g. Plate 1, Plate 2, etc.), right clicking the last plate selected, and selecting Remove Plates. 

 

Clear Plate 

• Navigate to the plate from which you want to clear all fluids. You can select multiple plates by holding 
down the CTRL key and selecting wells of interest on multiple plates. 

• Click Clear Plate on the Advanced ribbon tab. A dialog box is displayed, asking you to confirm the clear or 
cancel it. 

 

• Click Clear to clear the current plate of all fluids, turning it into an “empty” plate. Click Cancel to stop the 
clear. Note that clearing the plate does not remove fluids from the Fluids List. 

Replicate Plate 

This function is handy for an automatic, one-step creation of a new plate with the exact characteristics of the 
current plate, including Normalization and Randomization. In contrast, the Copy All Wells function described 
previously allows you to copy the well fluid contents from one plate to another plate without copying 
randomization and without constraints on the plate types. 

• Navigate to the plate that you want to replicate. 
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• Click Replicate Plate on the Advanced ribbon tab. A new plate with the exact characteristics is then created 
and appended to the end of the plate series; the new plate becomes the current plate. 

 

 

Ribbon–Advanced tab 

 

The Advanced ribbon tab contains features in addition to the Plate functions. 

Copy/Paste Fluids from the fluid list 

This function allows you to copy a Fluid List from one protocol to another or from a separate list of fluids, such 
as from a Microsoft Excel file (refer to Appendix B–Moving data between the dispensing software and other 
programs for information about this function). This function is handy when you are creating a new protocol that 
is similar to an existing one, and you do not want to enter a new Fluid List from scratch. 

• Open the source protocol, and then click Copy All Fluids. This copies the current Fluid List to the clipboard. 

• Bring up the target protocol and click Paste Fluids. This brings in the entire Fluid List from the source, 
modifying any changed parameters of existing fluids in the target protocol (matched by name) and 
appending new fluids to the Fluid List. 

• Replace Fluids will replace each existing fluid with pasted fluids in the order they occur.  All fluid 
parameters are changed to match the source. This allows you to use the same protocol repeatedly, but 
with fluids of different properties (name, stock concentration, source location names). Certain fluid 
properties cannot be changed (unit type). 

Lock and unlock wells 

Selected wells can be locked to prevent inadvertent changes to well fluids. Locked wells show a lock icon and 
cannot be selected. 

 

If a Paste operation would overwrite a locked well, an error is displayed. 
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Plate moves 

Use the ribbon buttons to move the current plate relative to other plates in the protocol.  These features are 
also available from the menu Plate-associated information bar. 

Utilities 

You must have a device connected to use these features. 

• You can check the dispense head(s) on a cassette by pressing the Cassette Check button.  From the dialog 
box press Check to test a cassette and display results. 

• Set Device ID allows you to give a unique name to the device which is included in reports run on that 
device. 

• A1 Alignment is used to adjust the A1 position.  Refer to the dispenser Operating Manual by navigating to 
the  File → Documentation menu of the software for more detail. 

 

 

Ribbon–Current Protocol tab 

 

The functions on this tab apply to the current protocol, and any changes are saved in the current protocol file. 

Concentration and Volume units  

Well fluids are displayed using the specified units of concentration and volume. 

Shake during dispense 

 

TIP:  It is highly recommended to shake during dispense for cellular assays when dispensing DMSO, 
particularly for larger volumes, to prevent DMSO from sinking to the well bottom and creating a local 
excess of DMSO and compound. 

 
To aid in mixing the dispensed fluids you can program the dispenser to shake the well plate while it is 
dispensing fluids. The dispenser shaking intensity parameters were optimized by plate type and are not user 
selectable. The duration of the shaking for each dispense event depends on the amount of dispensing 
occurring; wells with large amounts of fluid will be shaken longer because it takes more time to dispense them. 
This type of shaking will occur for every well dispensed for all fluids, as long as the dispensed volume exceeds 
the programmed Volume Threshold. Manually enter a Volume Threshold (in nL) and check the Shake during 
dispense box. When dispensing DMSO onto plated cells, it is recommended that shake during dispensing is 
turned on for any volumes greater than 100nL. 

 

 
NOTE: Shake during dispense is automatically enabled when a low-density plate (48 wells or fewer) is 
created, however, it can be disabled. 

 

 
NOTE: Shaking is always disabled for 1536-well plates, regardless of the protocol setting. 
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Shake after each dispense head 

 

TIP:  If not mixing off-line after dispensing, in addition to shake during dispense it is also 
recommended to shake after each dispense head on each plate for DMSO dispensing. Depending on 
the dispensed volumes, additional volume, and plate type you should determine the shake duration 
during assay development or by visually testing the mixing of dye/DMSO in your well plate. Shake 
after each dispense head is not recommended when dispensing aqueous fluids. 

 
To aid in mixing the dispensed fluids, you can program the dispenser to shake the well plate after each 
dispense head has completed dispensing on the current plate. The shaking intensity parameters were 
optimized by plate type and are not user selectable.  

Manually enter a shake Duration (in seconds) and check the Shake after each dispense head box. The duration 
is typically 3 seconds for a 384-well plate or 20 seconds for a 24-well plate. 

 
NOTE: Shaking is always disabled for 1536-well plates, regardless of the protocol setting. 

 

Dispense fluids in successful single cell wells 

Check the Dispense fluids in successful single cell wells box to dispense fluids only in wells where a single cell 
was successfully isolated. To dispense fluids regardless of single cell status in a given well, leave this box 
unchecked. 

 
NOTE: Wells determined to not contain a single cell contain an undefined number of cells: n=0 or n>1 
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Special features 

Synergy 

 

The Synergy function allows you to create a plate design for a drug-drug interaction or synergy experiment 
where multiple compounds are placed in the same well for many wells in a set of orthogonal titration 
sequences. The dispenser makes it especially easy to create synergy sequences because of the non-contact 
digital dispensing. Each compound is added to every well independently, and multiple compounds can be 
added to the same wells with no additional user effort. Synergy wells can also be normalized and randomized, 
if desired. 

On the Home Tab, click Synergy to create a synergy sequence. You then navigate and enter parameters in a 
series of pages to create the sequence. Once you have completed the procedure, a new plate or plates with the 
synergy layout is added to the protocol. 

 

 

NOTE: When using the Synergy function, it is not necessary to pre-select the wells to which you wish 
to apply fluids. The Synergy function automatically creates new plates with the programmed well 
content and ignores any wells that you may have already selected in an existing plate. 

 

Type page 
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There are two types of Synergy experiments available.  The first type factors all of the fluids together. The 
second type of experiment factors a single fluid against a group of other fluids one at a time. 

• Select the synergy experiment type. 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 

Plate page 

  

• Assign the Plate type, Additional volume, and DMSO limit in the fields provided at the top of the dialog box 
– the current plate’s parameters are the defaults. 

 

 
NOTE: DMSO limit is only displayed when DMSO fluids are in the protocol. 

 

• If desired, click the row letter(s) and/or column number(s) to select the rows and columns of wells that 
should be excluded from the synergy layout. In the figure above, the user excluded rows A, H and columns 
6, 7  from the layout. To de-select a row or column, just click the row letter or column number again. This 
can be used to leave rows or columns empty for use with controls.  

• If rows or columns have been excluded, you have the option to keep the primary Synergy grid from 
crossing excluded wells (if possible). 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 
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Titration page – A*B*C type 

The titration page is different depending on the type of synergy experiment selected on the Type page. 

 

 

The first two synergy fluids will form the primary synergy grid.  The first fluid will flow down the non-excluded 
rows and the second fluid will flow across the non-excluded columns. The number of available rows and 
columns is displayed for reference. 

Use the plus  button on the right edge to add additional fluids from the fluids list to the synergy. 
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For each synergy fluid, choose Titration, Targeted Titration, or Set Value. 

• Specify the number of Titration levels via manual entry. 

• Fill out all other fields according to instructions in the Titration, Targeted titration, or Set value sections. 

• You can Include “0” value by clicking the check box. 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 

 

 
NOTE: A fluid shift or extension may be suggested.  See the Fluid shift or extend section for more 
information. 

 

Titration page – A*B  A*C  A*D  A*E type 

The titration page is different depending on the type of synergy experiment selected on the Type page. 

 

 

The primary titration fluid is used for non-excluded rows of the synergy grid. A separate grid will be created for 
each secondary fluid. The secondary fluid will flow across non-excluded columns. 

• Select the secondary fluid(s) to be used by clicking the checkbox next to the fluid name (below left). You 
can de-select an already-selected fluid by re-clicking the checkbox to clear it. Additionally, you can select 
all fluids by clicking the Fluids checkbox at the top of the list. 
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NOTE: You cannot select secondary fluids with different unit types (molarity vs. mass/volume) or 
dispense modes (by concentration/volume) for the same Synergy experiment. 

 
For both the primary and secondary synergy fluids, choose Titration, Targeted Titration, or Set Concentration (or 
Volume). 

• Specify the number of Titration levels via manual entry. 

• Fill out all other fields according to instructions in the Titration, Targeted titration, or Set value sections. 

• You can Include “0” value by clicking the check box. 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 

 

 
NOTE: A fluid shift or extension may be suggested.  See the Fluid shift or extend section for more 
information. 

 

Layout page 

 

Choose how to arrange the synergy titrations on the plate. Select a layout option by clicking the associated 
button(s): 

• Layout does not leave empty wells: This option fills in all the wells along the columns, starting in A1, and 
does not leave empty rows or columns. It might not result in neatly ordered titration levels.  Wells are 
filled by row or column as specified. 

For the remaining options, titration levels of the first 2 fluids determine the number of rows and columns in the 
layout grid. They start by creating a primary synergy grid from the first two fluids, repeating that grid combined 
with the remaining fluids as needed. 
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• Each plate contains a single grid:  Only a single synergy grid will be placed on each plate. 

• Each plate contains multiple grids:  If multiple copies of the primary synergy grid can be placed on a plate, 
they will be placed by row or column as specified. 

• Each plate contains multiple grids, with plate breaks:  Plate breaks will be made to keep titration 
sequences together.  For example: 

If 9 primary synergy grids fit on each plate. 

If 3rd fluid has 5 levels and 4th fluid has 3 levels, 5 grids will be placed on each plate. 

If 3rd fluid has 2 levels, 4th fluid has 4 levels, and 5th fluid has 3 levels, 8 grids will be 
placed on each plate. 

 

 
NOTE: Not all of the layout options may be available, depending on the synergy Type, Titration 
options and Plate options. 

 

Summary page 

 

In the final page you are given a summary of the number of wells and plates needed and an illustration of what 
the well contents in the Synergy plate(s) will look like. The mouse can be moved over individual wells to display 
contents. 

Normalize 

If you want to normalize all of the wells in the synergy experiment, click the Normalize wells button and specify 
the normalization (see Normalize). 
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Randomize 

If you want to randomize all of the wells in the synergy experiment, click the Randomize each plate checkbox. 
Each plate will be randomized separately. 

Click Finish to create the synergy titrations. Back and Cancel are also available. 

Once you click Finish, the new Synergy plate (or plates) is added to the protocol and becomes the current plate. 

 

 

NOTE: If Aqueous fluids are in use for the Synergy 
wizard and more than 8 plates are generated a 
warning message is displayed. 

  

 

Quick plate 

 

The Quick Plate function allows you to create a group of identical titrations using multiple different fluids. This 
is useful when you want to make identical titrations with many fluids in the fluid list in only a few steps. The 
titrations can span multiple plates but must have the same concentrations and number of replicates. 

On the Home Tab, click Quick Plate. Similar to Synergy, you then navigate and enter parameters in a series of 
dialog boxes to create the plates. Once you have completed the procedure, the new plates are added to the 
protocol. 

 

 

NOTE: When using the Quick Plate function, it is not necessary to pre-select the wells to which you 
wish to apply fluids. The Quick Plate function automatically creates new plates with the programmed 
well content and ignores any wells that you may have already selected in an existing plate. 
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Plate page 

  

 

• Assign the Plate type, Additional volume, and DMSO limit in the fields provided at the top of the dialog box 
– the current plate’s parameters are the defaults. 

 

 
NOTE: DMSO limit is only displayed when DMSO fluids are in the protocol. 

 

• If desired, click the row letter(s) and/or column number(s) to select the rows and columns of wells that 
should be excluded from the Quick Plate layout. In the figure above (right), the user excluded row D and 
columns 11 and 12 from the layout. To de-select a row or column, just click the row letter or column 
number again. 

• If rows or columns have been excluded, you have the option of apply fluid Layout to each region 
separately. The default is to skip over excluded rows and columns during layout. 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure and discard all 
modifications. 
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Fluid & titration page 

 

• Select the fluid(s) to be used by clicking the checkbox next to the fluid name (below left). You can de-
select an already-selected fluid by re-clicking the checkbox to clear it. Additionally, you can select all fluids 
by clicking the Fluids checkbox at the top of the list. 

 

  

 

 
NOTE: You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense 
modes (by concentration/volume) for the same Quick Plate Titration. 

 

To set up Quick Plate Titration, you must enter information similar to that needed for Titration or Targeted 
Titration: 

• Specify the number of titration levels desired for each fluid. 

• Choose Titration or Targeted titration and then follow the instructions in the Titration or Targeted titration 
sections. 
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Once all parameters have been entered, click Next to go on to the next Quick Plate step. Back and Cancel are 
also available. 

 

 
NOTE: A fluid shift or extension may be suggested.  See the Fluid shift or extend section for more 
information. 

Layout page 

 

The Quick Plate Layout step allows you to decide how the titration series are laid out in the plate. You can 
arrange the titration points in many ways, including with the different fluids interleaved if desired. With your 
desired layout in mind, adjust the Quick Plate outcome by experimenting with various layout settings. As you 
change the primary layout settings, you can see the effects in the example layout options. 

 

 
NOTE: Several of the setting options will change based on previous selections. 

 

Layout 

• Layout by rows: The Well plate grid shows a layout with each fluid’s replicate levels progressing across a 
row. 

• Layout by columns: The Well plate grid shows a layout with each fluid’s replicate levels progressing down 
a column. 
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Replicate layout 

Choose to keep replicate levels together or not. Keeping replicate levels together will keep all the concentration 
replicates of each fluid together. Not keeping replicate levels together will instead keep the fluid’s titration 
series, of decreasing concentration, together. The remaining choices will adjust to the selection here. 

Interleave fluids 

• Do not interleave: The wells for each fluid are maintained together, according to the other layout 
selections. 

• Change fluid after each level replicate (option available when keep replicate levels together is selected): 
After all the replicated for a given fluid level are applied, the next fluid will then be placed into the wells, 
until all of the fluids are placed. Then, the next set of level replicates for the first fluid will be applied, etc. 

• Change fluid after each singlicate (option available when keep replicate levels together is not selected): All 
the titration levels for a single fluid are applied to the wells, then the titration levels of the next fluid are 
applied, until all the non-replicated fluid titration levels are applied. Then the replicates for all the fluids 
are applied in the same manner.  

• Change fluid after each well: If replicate levels are kept together, this option places the first titration level 
of each fluid into the wells, changing fluid for every well. Then the replicates for all the fluids are applied in 
the same manner, followed by the other titration levels, until all the levels and replicates have been 
applied.  

However, if replicate levels are not being kept together, this option places the first titration level of each 
fluid into the wells, changing fluid for every well. Then it places the next titration level for each fluid in the 
same manner until all the singlicates for all the fluids have been placed. Then the replicates for all the 
fluids are applied in the same manner. 

Example layout options 

The final layout selection affects the flow of the layout. Example layouts are shown for each option. These 
options vary significantly based on previous selections. Move the mouse over an option to display a brief 
description of the layout behavior. 

 

Once all parameters have been entered, click Next to go on to the next Quick Plate step. Back and Cancel are 
also available. 
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Summary page 

The Summary gives you an illustration of how the new plate will look. It also indicates the number of wells and 
plates involved in the scheme.  

The mouse can be moved over individual wells to display contents. 

 

Click Finish to create the new plate(s). The new plate will then become the current plate. Back and Cancel are 
also available. 

 

 

NOTE: If Aqueous fluids are in use for 
the Quick plate wizard and more than 8 
plates are generated a warning 
message is displayed. 

  

 

Quick plate examples 

In this section, several examples will be provided for Quick Plate layouts that increase in complexity. These 
examples are intended to provide initial guidance for how to use the different layout options in Quick Plate. 
They are not intended to be exhaustive, and it is recommended that users experiment with the various layout 
options to achieve the desired plate layout. 
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Example 1: One 96-well plate with 8-point triplicates of four compounds 

This example uses all the wells of the 96-well plate, with no columns or rows used for controls/left blank. 

The titrations are laid out in columns, with the replicate series placed in adjacent columns. 

The desired resulting plate is shown, along with the titration and layout page selections made to generate the 
plate. 

 

In the Fluids & Titration page, select the fluids to apply to the newly created quick plates and specify the 
Titration or Targeted titration details, including number of levels, number of replicates, and concentration range 
and distribution. 
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In the Layout page, specify how to arrange the desired wells in the newly created plate/s. The example 
provides visual guidance regarding the impact of the different selections, but it does not represent the actual 
plate that will result. The resulting plate/s are shown after Next is clicked, at which point you may still click Back 
within the Quick Plate setup. 

 

 

Example 2: Three 96-well plates with 10-point triplicates of six compounds, replicates in different plates 

In the second example, more compounds are applied to multiple 96-well plates using the Quick Plate function. 
The six fluids are titrated as 10-point triplicates, with unused rows and columns at the plate edges. In this 
example, the replicates are applied to different plates, so the fluid singlicates are interleaved in the plate 
layout. Shown below are the desired plates and the Quick Plate pages used to generate them. 
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In the Plate page, select any rows and/or columns to exclude from the layout. In this case, the plate perimeter 
was excluded. 

 

 

 

In the Fluids & titrations page, select the fluids to apply to the newly created quick plates and specify the 
Titration or Targeted titration details, including number of levels, number of replicates, and concentration range 
and distribution. 
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In the Layout page, specify how to arrange the desired wells in the newly created plate(s). For this example, to 
place the replicates into different plates, we select the option interleave fluids – change fluid after each 
singlicate. 

 

 

Example 3: One 384-well plate with 10-point duplicates of 16 compounds, interleaved 

In the third example, a plate with multiple fluids that alternate, or are interleaved, on a well-by-well basis will 
be created. This plate layout might be applicable if you need to match existing plates that have been generated 
by transferring wells from a 96-well to a 384-well plate. The two outermost columns on each side of the plate 
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are excluded from this layout. The desired plate layout, using 16 fluids titrated in 10-point replicates, is shown, 
along with the titration and plate layout pages used to generate the plate. 

In the Plate page, select the plate type and any rows and/or columns to exclude from the layout. In this case, a 
384-well plate was selected and two columns at the left edge excluded. 

 

In the Fluids & titrations page, select the fluids to apply to the newly created quick plates and specify the 
Titration or Targeted titration details, including number of levels, number of replicates, and concentration range 
and distribution. 
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In the Layout page, specify how to arrange the desired wells in the newly created plate/s. For this example, to 
achieve the desired layout, we have to lay out the fluids by columns and keep replicate levels together. Then, to 
achieve the interleaved pattern, we change fluid after each level replicate and keep the levels together, starting 
each level on a new column. 
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Enzyme Profile 

 

The Enzyme Profile function allows you to automate the process of enzymatic assay development, validation, 
and generation of Michaelis-Menten kinetic analyses and Lineweaver-Burk plots (for example).   

Once the enzymes, substrates/cofactors, and inhibitors are set up as fluids, you can design well layouts where 
enzymes, substrates/cofactors, or inhibitors are dispensed in constant (fixed) or variable (titrated) amounts.  
This makes it easy to determine the proper enzyme and substrate/cofactor concentrations, and inhibition 
mechanisms for enzymatic assays. 

On the Home Tab, click Enzyme Profile. You then navigate and enter parameters in a series of dialog boxes to 
create the plates. Once you have completed the procedure, the new plates are added to the protocol.  

 

 

NOTE: When using the Enzyme Profile function, it is not necessary to pre-select the wells to which 
you wish to apply fluids. The Enzyme Profile function automatically creates new plates with the 
programmed well content and ignores any wells that you may have already selected in an existing 
plate. 

Plate page 

  

• Assign the Plate type, Additional volume, and DMSO limit in the fields provided at the top of the dialog box 
– the current plate’s parameters are the defaults. 

 

 
NOTE: DMSO limit is only displayed when DMSO fluids are in the protocol. 

 

• If desired, click the row letter(s) and/or column number(s) to select the rows and columns of wells that 
should be excluded from the Enzyme Profile layout. In the figure above (right), the user excluded columns 
6 and 7 from the layout. To de-select a row or column, just click the row letter or column number again. 



 

 Dispensing Software 65 

 

• If rows or columns have been excluded, you have the option of apply fluid Layout to each region 
separately.  The default is to skip over excluded rows and columns during layout. 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 

 

Fluids page 
 

 

Select fluids to be used as enzymes, substrates/cofactors, and inhibitors. 

• You must select one or two enzymes. 

• You may select one or two substrates/cofactors, but you do not need to select any. 

• You may select one or more inhibitors, but you do not need to select any. All inhibitors will be titrated 
using the same settings. 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 

 

 
NOTE: You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense 
modes (by concentration/volume) in a list. 
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Type page 

 

• Select one or two fluids for titration. Fluids not selected for titration will be dispensed at a fixed volume or 
concentration. 

• If two fluids are selected for titration, you can also choose which fluid will be titrated down rows and which 
will be titrated across columns. 

• Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 
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Titration page 

 

For each titrated fluid, choose Titration, or Targeted Titration. 

• Specify the number of Titration levels via manual entry. 

• Fill out all other fields according to instructions in the Titration or Targeted titration sections. 

• You can Include “0” value by clicking the check box. 

• Distribution is pre-selected as Linear or Logarithmic depending on the type of fluid, but you can change 
the selection. 

If there are two titration fluids, they will form a titration grid, flowing down the non-excluded rows and across 
the non-excluded columns. The number of available rows and columns is displayed for reference. 

• For each non-titrated fluids, specify a fixed volume or concentration. 

Click Next to go onto the next step or Cancel to abort the in-process layout procedure. 
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Layout page 

  

 

Layout options will vary depending on the number of titrated and fixed fluids, plate settings, etc. 

Select a primary layout option and then detailed options for that layout.  In the example above, checking or 
clearing the “Allow multiple layout grids per plate” checkbox will change the example graphics and detailed 
options available. 

Summary page 

The Summary gives you an illustration of how the new plate will look. It also indicates the number of wells and 
plates involved in the scheme.  

The mouse can be moved over individual wells to display contents. 



 

 Dispensing Software 69 

 

 

Click Finish to create the new plate(s). The new plate will then become the current plate. Back and Cancel are 
also available. 

 

 

NOTE: If Aqueous fluids are in use for the 
Enzyme profile wizard and more than 8 plates 
are generated a warning message is displayed. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 Dispensing Software 70 

 

PCR 

 

The PCR function allows you to automate the process of designing well plates for PCR experiments.  This 
involves setting up dispense of master mixes, primers (also known as targets or probes) and samples (also 
known as templates) using the dispenser. Master mixes that are added using another dispense technology 
should be specified as “Additional Volume” on the Plate Page below. 

Before using the PCR function, all fluids must be defined. If master mixes are premixed with primers, enter each 
mixture as a single fluid. Master mixes must be set to dispense by volume. 

After fluids to be dispensed are defined, protocols can be designed where all wells have the same master mix 
volumes. All master mixes will be dispensed in every well of the layout. For each primer/sample combination, 
the concentrations or volumes as well as the number of replicates can be specified. Optionally, standard curves 
and an NTC (no template control) region can be included; wells can be normalized to have the same total 
volume. 

On the Home Tab, click PCR. You then navigate and enter parameters in a series of dialog boxes to create the 
plates. Once you have completed the procedure, the new plates are added to the protocol. 

 

 

NOTE: When using the PCR function, it is not necessary to pre-select the wells to which you wish to 
apply fluids. The PCR function automatically creates new plates with the programmed well content 
and ignores any wells that you may have already selected in an existing plate. 

 

Plate page 

  

 

• Assign the Plate type, Additional volume, and DMSO limit in the fields provided at the top of the dialog box.  
The current plate’s type and DMSO limit will be the default choices; however, additional volume will always 
default to 0 (zero) for PCR, meaning that all well volume is added by the dispenser.  As noted above, if 
master mix is to be dispensed by another method, specify that master mix volume in the additional 
volume field.  
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NOTE: DMSO limit is only displayed when DMSO fluids are in the protocol. 

 

• If desired, click the row letter(s) and/or column number(s) to select the rows and columns of wells that 
should be excluded from the PCR layout. In the figure above (right), the user excluded column 12 from the 
layout. To de-select a row or column, just click the row letter or column number again. 

Click Next to go onto the next step or Cancel to abort the in-process PCR layout procedure. 

Fluids page 

  

 

Select Master Mix, Primer, and Sample fluids. Only fluids dispensed by volume are included in the Master Mix 
selection list. 

• You must select at least one primer. 

• You must select at least one sample. 

• You do not need to select any master mixes if your primers include master mix or if master mixes will be 
dispensed by another method. 

• You do not need to categorize all fluids. 

 

 

TIP:  If master mix is not to be dispensed by the dispenser, do not select any master mixes on the 
Fluids page, but include their volume as Additional Volume in the Plate tab (see Plate-associated 
information). 
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To add more information to your experimental groups including information about reporters, quenchers, and 
Biogroups. Reporter information is required when loading your dispense information report into Quantstudio™ 
as described in Appendix A–Reports under QuantStudio Compatible format (*.DA.csv) 

 

If protocol fluids have previously been assigned PCR tasks, a summary is displayed. Press Assign PCR Fluids to 
add or modify PCR fluid tasks. 

 

 

Click Next to go onto the next step or Cancel to abort the in-process PCR layout procedure. 
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Unknown Groups page 

 

This dispense volume for each Master Mix is specified separately and will be dispensed in all Unknown, 
Standard, and NTC wells. 

Multiple PCR Unknown groups can be specified. Use the plus  button on the right edge to add additional PCR 
groups. 

 

 

For each PCR Unknown group: 

• Specify the number of Replicates that will be created for each Primer/Sample combination. 

• All Primers in the group share a single dispense value. 
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• All Samples in the group share a single dispense value.  

• Each Sample will be dispensed separately with all Primers in the group. 

In this example, there are two Unknown groups. The first group uses 4 samples with 8 replicates, for a total of 
32 wells with two multiplex primers in each well. The second group uses 2 samples with 6 replicates, for a total 
of 12 wells. 

Click Next to go onto the next step or Cancel to abort the in-process PCR layout procedure. 

 

 
NOTE: You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense 
modes (by concentration/volume) in a list (column). 

Standards / NTCs page 

 

Optional Standards and NTC (No Template Controls) can be specified.  

Specify optional standards to be dispensed on one or all PCR plates. 

• If Standards is not checked, no standards will be planned. 

• Select one or more Primers and specify the fixed dispense volume or concentration for the standard. 

• Select one or more Samples (standards) and specify the titration to use for each standard. 

• The replicates setting in the titration panel will determine how many replicate standards are created for 
each primer/sample combination 

• Each primer will be combined separately with each sample. This is different from how the Unknown 
groups are planned where primers can be multiplexed. 

Specify optional NTC (No Template Control) region. 

• If NTCs is not checked, no NTCs will be planned. 

• Specify the Replicates to be used for each primer. 

• Select one or more Primers and specify the fixed dispense volume or concentration. 

• Each primer is dispensed separately. 
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If Standards/NTCs on each plate is not checked, standards and NTCs will only be dispensed on the first PCR 
plate.  

Click Next to go onto the next step or Cancel to abort the in-process PCR layout procedure. 

 

 
NOTE: You cannot select fluids with different unit types (molarity vs. mass/volume) or dispense 
modes (by concentration/volume) in a list (column). 

Layout page 

 

 

 

If Standards or NTCs were specified, there are additional layout options. 

• Standards/NTCs can be located down the left and right edges or along the top and bottom edges of the 
plate. 

• Standards can be condensed so the next replicate will occur immediately following the previous replicate 
even if that results in curves being broken across columns or rows. The NTC region is always condensed. 

Changing the columns/combination setting will cause the PCR regions to change shape in the layout. 

Since all replicated combinations will be planned on the same plate, multiple plates may be required for all of 
the primer/sample combinations. 

You can also create a layout that does not leave any empty wells by selecting the checkbox at the top of the 
page. 

Click Next to go onto the next step or Cancel to abort the in-process PCR layout procedure. 
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Summary page 

The Summary gives you an illustration of how the new plate will look. It also indicates the number of wells and 
plates involved in the scheme. 

The mouse can be moved over individual wells to display contents. Unknown groups, Standard, and NTC areas 
are indicated below. 

 

 

It is optional to Normalize PCR wells. It may be desirable to normalize to a constant total assay volume if 
samples are different concentrations. This would typically be accomplished by normalizing with water and 
surfactant using an aqueous fluid class. 

Click Finish to create the new plate(s). The new plate will then become the current plate. Back and Cancel are 
also available. 

Well tooltips show PCR information for all PCR fluids (Master Mix, Primer, and Sample) and wells (Unknown, 
Standard, and NTC). 
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Manual PCR specification 

It is possible to specify PCR information outside of the automated process. It may be that you need to create 
Standards with specific values that are simple to create manually, or to use multiplexed primers for Standards 
or NTCs. The automated PCR process could continue to be used to create the Unknown groups. 

PCR Fluid and Task assignments can be made from the PCR ribbon drop-down menu. Task assignments can 
also be made from the right-click well menu. 

 

 

To assign a group of wells to a PCR task, select the wells and then select the task from the PCR menu. You can 
also remove any existing task assignments. 
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Running a fluid dispensing protocol 

The dispensing software provides the environment for you to set up a protocol and run that protocol, either for 
dispensing fluids or isolating single cells. The runs can be: 

• an actual run with your system connected to a dispenser and requiring physical loading of plates and 
cassettes, or 

• a simulated run that gives you a preview of how a protocol will play out, with all the features of an actual 
run. 

Run menu 

 

 

 

Park Plate Holder will retract the plate holder. 

Always Simulate will simulate protocol runs, even if a device is connected. When Always Simulate is active, the 
Run button changes to Simulate. 

 

Initial display and dialog 

Load your protocol into the Main Operating Window. Then click the Run button on the Home Tab. 

 

 

The dispensing software checks for a connection to a dispenser. If the software fails to detect a device, a dialog 
box is displayed, asking if you want to Simulate a run, Retry the connection for an actual run, or Cancel the run 
altogether. 
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NOTE: To minimize evaporation, a protocol run dispensing aqueous fluid classes will be limited to 
1536 wells or four plates. 

 

 

NOTE: To ensure optimum performance, it is recommended that all plates include a well with volume 
of 30nL or greater for each fluid.  Refer to Appendix F–Best practices for dispensing for more 
information. 

 

The initial Run Window is then displayed. 

 

The left area indicates the number of fluids and dispense heads that will be needed for the run. There is also a 
Start button to initiate the dispensing preparation and the subsequent run. Note that if the plate has 
normalized wells, the protocol calls for normalization fluids. 

If high-volume dispense heads are appropriate for this protocol, the number of dispense heads will be listed for 
each cassette type.  You can override the high-volume recommendation with the Use high-volume cassettes 
checkbox if you do not want to use high-volume cassettes. The default state of the checkbox is set in Run 
Settings. 

If text is entered into the Report Notes area, those notes will be written to the report file created after the run. 
Notes can also be added for each fluid, by clicking the Fluid Notes button. 

The total load volume for each fluid is listed in the right portion of the screen along with a display of the current 
shake parameters for wells and plates. Changing these parameters changes the protocol. From this area it is 
also possible to enter Settings and modify report options. 

 

 
NOTE: The protocol shake parameters are indicated, but individual plates may have Don’t Shake 
selected. 

 

Click Start to move onto the next phase of the run. 



 

 Dispensing Software 80 

 

 

Running a protocol on the dispenser 

Refer to the dispenser Operating Manual for detailed information about running a protocol on the dispenser. 

Run complete 

 

If report settings are set to generate a report on every run, a message appears to let you know that the report 
is being generated. For information on what to look for in your report, see Appendix A–Reports. 

If a report is not automatically saved, it can later be saved using Save Report from the Run menu. 

Click Close to return to the Operating Window. Click Park plate holder and Close to retract the plate holder 
before closing. You can always retract the plate holder from the Run menu. 
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Running a single cell dispensing protocol 

Single cell dispensing and isolation into well plates up to 384 wells can be accomplished with the HP D100 
Digital Dispenser.  The D300e Digital Dispenser cannot be used for this purpose at this time due to electronic 
sensing limitations.  On the D100, single cell cassettes are required for this workflow, please see Appendix E–
Dispense specifications for more information about these cassettes. 

 

 

NOTE: To ensure optimum performance, it is recommended that specific procedures be followed for 
cell stock generation and single cell protocols.  Refer to Appendix F–Best practices for dispensing for 
more information. 

 

Cell dispense fluids 

Add or modify a cell fluid group and class. Select Cells or Sticky Cells in the Fluid Group depending on your cells. 
Sticky cells require more clearing volume to dispense through the microfluidics. Use the Fluid class that 
corresponds to your average cell diameter: Small (10-14µm), Medium (15-17µm), Large (18-20µm) or Extra-
Large (21-25µm). A concentration of 200 cells/µL is recommended for optimum performance. 

 

 

 

Cell dispense wells 

Add the cell fluid to the wells you wish to contain isolated single cells by selecting the wells and using Set Value 
from the Home tab tool bar: 
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If you want to add reagents to isolated single cell wells in this protocol, there are two options. The figure below 
shows the main display after a single cell isolation run is performed. 

In the Current Protocol tab of the Ribbon, there is a check box to Dispense fluids in successful single cell wells. 
If the box is checked prior to the run, the subsequent non-cell fluids will only be dispensed into selected wells 
that contain a single cell. If the box is unchecked, subsequent non-cell fluids will be dispensed in all selected 
wells including the non-single cell wells (marked with an X).  
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Running a single cell dispense protocol 

Then click the Run button on the Home Tab. 

 

The dispensing software checks for a connection to a dispenser. If the software fails to detect a device, a dialog 
box is displayed, asking if you want to Simulate a run, Retry the connection for an actual run, or Cancel the run 
altogether. 

 

The initial Run Window is then displayed. 

 

 

The left area indicates the number of fluids and dispense heads that will be needed for the run. The right side 
indicates the concentration and volume of cell solution required. The Start button initiates the dispensing 
preparation and the subsequent run.  

If text is entered into the Report Notes area, those notes will be written to the report file created after the run. 
Notes can also be added for each fluid, by clicking the Fluid Notes button. 

Click Start to begin the dispense. 
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NOTE: To ensure optimum performance, it is recommended that specific procedures be followed for 
cell stock preparation.  Refer to Appendix F–Best practices for dispensing for more information. 

 

Running a single cell dispense protocol  

Refer to the dispenser Operating Manual by navigating to the File → Documentation menu for detailed 
information about running a single cell dispensing protocol. 

 

Run complete 

 

If report settings are set to generate a report on every run, a message appears to let you know that the report 
is being generated. For information on what to look for in your report, see Appendix A–Reports.  

Note that the Counted Cell Dispense Summary for the plate is shown above in the Run completed screen as 
well as in the report. Specific wells reported to contain single cells are also shown in the right hand plate 
graphic. 

If a report is not automatically saved, it can later be saved using Save Report from the Run menu. 

Click Close to return to the Operating Window. Click Park plate holder and Close to retract the plate holder 
before closing. You can always retract the plate holder from the Run menu. 
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Settings 

In the Main Operating Window File Menu, click Settings to assign application-wide parameters and values. 

1. Each section is opened by clicking on the section title region.  Some sections will scroll to access all 
settings. 

2. Edit the settings via specified drop-down menu choices, manual entry, check box/radio button, or 
browsing. 

3. Once you have updated the settings, click OK to save them or Cancel to ignore all changes made in the 
current Settings session. 

4. Note that you can override many application settings with protocol-specific settings described in previous 
chapters. 
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Default values 

There are a number of values which are automatically filled in with defaults that may be changed. For instance, 
when you create a new protocol or add a fluid or plate, the default settings are used. However, any of the 
values can be changed when you first set up a protocol or later on in the protocol preparation process. 
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Item Measure Choices 

Default protocol 
values 

Molarity concentration units for new protocols Drop-down menu 

Mass concentration units for new protocols Drop-down menu 

Volume units for new protocols Drop-down menu 

 shake during dispense If checked, shake during dispense will be 
enabled 

Volume threshold for shake during dispense Manual entry 

Enable shake after each dispense head If checked, shake after each dispense head 
will be enabled 

Shake duration after each dispense head Manual entry 

Default fluid 
values 

 

Fluid class for new fluids Drop-down menu 

Concentration and units for new fluids Manual entry and drop-down menu. 

Dispense mode for new fluids Toggle button 

Default plate 
values 

Plate type for new protocols Drop-down menu 

DMSO limit for new protocols Manual entry 

Normalization Default dispense order Drop-down menu 

Additional 
volumes 

Default additional volume for each plate type Drop-down menu with manual entry. 

For each well plate type, you can assign a 
default additional volume.  

 

Display 

You can set up the default software parameters for how numbers, concentrations and volumes, will be 
displayed. Changing these settings does not impact how dispensing occurs, just how numbers are displayed. 

 

Item Measure Choices 

Wells Concentration significant digits (minimum) Manual entry – 2 to 8 

Volume significant digits (minimum) Manual entry – 2 to 8 

Fluids Concentration decimal places Manual entry – maximum of 4 

Volume decimal places Manual entry – maximum of 4 

Show more information in fluid list Check to show more fluid information in the 
fluid list on the main operating window. 
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Reports 

The reports menu allows you to set system defaults for report generation. More information about Reports can 
be found in Appendix A–Reports. 
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Item Value 

Auto-save 
reports after 
protocol run 

If the box is un-checked, reports must be manually saved after each protocol run (Save Report in Run menu). 

If the box is checked, you can set the auto-save report parameters and you will not be prompted for report save 
after each run. 

• Do not save aborted protocol runs: Check this box so that reports are not saved after an aborted run. 

• Report file name:  

o Name is the protocol name combined with date and time.  Click this to produce unique report names after 
each run. 

o Fixed name.  Selecting this option will give the same name to each protocol report. Manually enter the 
desired report filename. Select whether a new file is saved with an appended name – e.g., ReportName(1) 
or if older files are overwritten. 

 

• If report file already exists: Select additional naming conventions for reports with the same name. 

• Report formats: Select one or more output formats. 

Report options • To round report data, click the Round to radio button and enter the number of significant digits. 

 

• Check to include “Don’t Dispense” fluid tables in reports. 

• Check to include empty well lines in the “Tabular detail” table of reports. 

• Check to include revision history in reports. 

PDF report 
options 

• PDF reports can be written for Letter or A4 page size. 

• Check to include signature lines in PDF. 

• Check to digitally sign reports using a certificate. If checked, you can select a certificate to use for signing. 
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File locations 

The file locations menu allows you to set system defaults for protocol and report folders. This is also useful to 
recall where reports and protocols are saved on your computer. 

 

Item Value 

Protocol folder Use the system-assigned default or click the Browse button to search and assign the folder in which protocols are 
stored. 

Report folder Use the system-assigned default or click the Browse button to search and assign the folder in which reports should 
be written. 

 

Run 

 

Item Choices 

Default to use high-volume 
cassettes 

The Use high-volume cassettes checkbox on the protocol Run screen will default to this setting. 

Show “remove plate lid” reminder If checked, a reminder will display each time a plate is loaded. 

Require and validate plate ID If checked, a plate ID is required and must be re-entered (and validated) each time the plate is 
loaded. 

Do not show Help panel If checked, the help panel will not be displayed. 
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Appendix A–Reports 

Report file formats 

The dispensing software outputs report files in five formats: 

• Excel Compatible XML format (*.xml): This Excel-specific XML (eXtensible Markup Language) file contains 
useful details from running a protocol in a file format designed to be opened and viewed in Microsoft 
Excel. This file includes formatting (page tabs and cell formatting) to improve direct reading by the user. 
The tabs within this format are described extensively within this appendix. 

• Comma Separated Values (*.csv): This contains the same information as the Excel XML format, but in a 
comma delimited format. This format may be more useful for importing protocol information into a LIMS 
system. 

• Adobe Acrobat PDF format (*.pdf): This file is intended to be less readily edited and can be generated with 
blank signature lines if desired for filing.  Additionally, these reports can be digitally signed by selecting a 
certificate. 

• QuantStudio Compatible format (*.DA.csv): This QuantStudio specific CSV file is formatted to enable 
importing qPCR plate designs into QuantStudio DA and DA2 software packages to reduce errors 
associated with recreating plate layouts in separate software packages. qPCR plates are easy to set up in 
the Digital Dispensing software as described elsewhere in this manual. 

• Data XML (*.DATA.xml):  This contains the same information as the Excel XML format but is in generic XML. 
This format may be more useful for importing protocol information into a LIMS system. 

Example (Excel-compatible XML) 

Below is an illustrative example of a protocol that contains multiple fluids, normalization, and randomization. 
This example is the basis for the report files used throughout the remainder of this Appendix.  Descriptions of 
the regions of this protocol follow below: 

 

1. Non-Randomized Region: This region of the protocol (A1-C9) is non-randomized. 

2. Normalized Region: This region of the protocol (B1-C6) is normalized to the level of the highest volume 
well within the region 
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3. Two-fluid synergy: This region of the protocol (A7-C9) contains a two-fluid synergy experiment 

4. Randomized Region: This region of the protocol (E1-G9) is a randomized replicate of the wells shown in 
region 1 (A1-C12) 

*Cells are displayed as the number 1 surrounded by a round symbol (red for this fluid color).  

Summary 

The Summary tab shows summary information for the protocol. This includes the file location of the protocol, 
start and finish time for the protocol, and key protocol information, including the dispense order for the 
normalization fluid (if used), and the settings for plate shaking (if used). 

 

Fluids 

The Fluids tab shows details of the fluids used within the protocol. The top section contains information about 
all fluids defined within the protocol, including fluids marked as No Dispense. This section also includes the fluid 
load volume requested by the software, and the dispensed volume. 

The second section contains information about the dispense heads and cassettes used within the protocol, 
including the mapping of fluid to dispense head number. In cases when a fluid is used in more than a single 
dispense head, the requested load volume and dispensed volume are shown by dispense head. 

The bottom section with Observed Cell Concentration reports the calculation of the cell stock concentration 
based upon the number of sensed cells per known volume dispensed.  This can be used to adjust cell stocks for 
improved performance as described in Appendix F–Best practices for dispensing. This calculation will only be 
displayed if 20 or more single cells have been successfully dispensed into wells.   

 

 

 

Fluid Fluid Name Stock Concentration

Stock Concentration 

Units Class Source Plate Source Well No Dispense

Dispense by 

Volume

Small 

Molecule

Dispense

Heads

Loaded 

Volume (µL)

Dispensed 

Volume (µL)

1 Cells 200 cells/µL CELL+S 1 20 0.052

2 Fluid 1 10 mM DMSO 2 13.8 11.5

3 Fluid 2 10 mM DMSO 2 13.8 11.5

4 DMSO normalization DMSO 1 14.2 12.1

Fluid Fluid Name Cassette Type Cassette

Dispense

Head Fill Time

Loaded 

Volume (µL)

Dispensed 

Volume (µL) Notes

1 Cells C1 1 1 14:49:58.6 20 0.052

2 Fluid 1 T1 2 1 14:52:02.0 6.9 5.7

2 Fluid 1 T1 3 1 14:52:05.0 6.9 5.7

3 Fluid 2 T1 4 1 14:52:08.0 6.9 5.7

3 Fluid 2 T1 5 1 14:52:11.0 6.9 5.7

4 DMSO normalization T1 6 1 14:52:16.0 14.2 12.1

Cassette Cassette ID Cassette Type

Observed Cell 

Concentration 

(cells/µL)

1 C1 190
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Plates 

The Plates tab shows information for all plates in the protocol, including plates marked as Don’t Dispense. This 
includes plate number (which corresponds to the order of the plates within the protocol) and the defined assay 
volume of the plate. The Plate name is defined by the user within the protocol setup, while the Plate ID is 
defined by the user within the run process the first time the plate is loaded onto the instrument. 

Tabular 

The Tabular tab shows dispensed concentration and volume in a columnar format. Each well within a protocol 
has a single row in the tab, and each fluid within the protocol has a single concentration column and a single 
volume column. Composite concentration and volume information columns are also found within the tab. 
Composite information column headers are colored black, whereas individual-fluid column headers are colored 
with their corresponding fluid color. Well locations are shown in alphanumeric (“A5”, “C12”) as well as numeric 
row and column formats. Rows are sorted by plate number, then dispensed row, and then dispensed column. 
Descriptions of the regions of this report file tab follow below: 

 

1. Well Contents – When a well contains a single fluid with or without a normalization fluid, the composite 
‘Fluid Name’ cell for that row will contain that fluid name and will be colored with the fluid color. When a 
well contains more than a single fluid (not including normalization fluid), the composite ‘Fluid Name’ cell 
for that row will be named ‘N fluids’, where N is the number of fluids within that well. The cell will be 
colored white. 

2. Concentration/count – When a well contains a single fluid with or without a normalization fluid, the 
composite ‘Concentration/Count’ cell for that row will contain the concentration (or count if doing cell 
dispensing) of that single fluid and will be colored with the fluid color. When a well contains more than a 
single fluid (not including normalization fluid), the composite ‘Concentration/Count’ cell for that row will 
be blank and will be colored white. 

3. Count (Cells) – When a well is reported to contain a single cell, the “Count” for that row is set to one, when 
it is reported to contain no single cells it reports a zero, and when that well is reported to contain more 
than one cell that row is set to “Non-single cell.” 

4. Total dispensed volume and total well volume – When a well contains a single fluid without a 
normalization fluid, the “Total Dispensed Volume” cell for that row will contain the volume of that single 
fluid and will be colored with the fluid color. When a well contains more than a single fluid (including 
normalization fluid), the composite “Total Volume” cell for that row will include the total volume, 
including the volume of the normalization fluid, and will be colored white. The Total Well Volume cell for 
that row is the sum of the dispensed volume and the additional volume set in the protocol. 

5. DMSO % - Only DMSO fluids and DMSO normalization are included in this calculation. 
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Tabular detail 

The Tabular Detail tab shows dispensed concentration and volume in an alternative columnar format. Each 
dispense within a protocol has a single row in the tab, and there are single columns within the protocol for 
Dispensed Concentration and Dispensed Volume of each dispense. This tab may be more useful for pulling 
protocol dispense information into a LIMS system. Normalization fluids do not have a dispensed concentration. 
The fluid number, fluid name, cassette number, and dispense head for each dispense are colored with their 
corresponding fluid color.  

Well locations are shown in alphanumeric (“A5”, “C12”) as well as numeric row and column formats. Rows are 
sorted by plate number, then dispensed row, and then dispensed column. In cases where there is a single fluid 
per well, each well will have a single row. In cases where there are multiple fluids per well, each well will have 
as many rows as it has fluids, including a separate row for the normalization fluid. In the example below, well 
B2 has two separate dispense events and two rows to correspond to fluid 1 and the normalization fluid. 

 

 

Figure 1   Tabular Detail tab example (row A and B) 

 

Dispense head – When the amount of any protocol fluids exceeds the maximum amount of fluid that can be 
loaded into a single dispense head, dispensing of the fluid is split between two or more dispense heads. The 
software distributes the required amount of fluid between these two or more dispense heads approximately 
equally. Occasionally, this causes a transition between dispense heads to occur within a single well. In this case, 
the report file will report the word “Multiple” within the dispense head column.  

The Tabular Detail tab contains a few other useful pieces of information highlighted below. Description follows: 

 

Figure 2   Tabular Detail tab randomized example (rows E) 

 

Plate 

ID Plate

Dispensed

Well

Dispensed

Row

Dispensed

Col

Non-random

Well

Non-random

Row

Non-random

Col Fluid Fluid Name Cassette

Dispense

Head

Dispensed 

Conc/Count Units

Dispensed 

Volume Units

Total Well 

Volume

1 A01 1 1 A01 1 1 1 Cells 1 1 0 cell 23.2 nL 100000

1 A02 1 2 A02 1 2 1 Cells 1 1 1 cell 0.48 nL 100000

1 A03 1 3 A03 1 3 1 Cells 1 1 1 cell 0.48 nL 100000

1 A04 1 4 A04 1 4 1 Cells 1 1 1 cell 0.48 nL 100000

1 A05 1 5 A05 1 5 1 Cells 1 1 1 cell 0.48 nL 100000

1 A06 1 6 A06 1 6 1 Cells 1 1 Non-single cell 9.64 nL 100000

1 A07 1 7 A07 1 7 2 Fluid 1 2 1 50 µM 503 nL 101000

1 A07 1 7 A07 1 7 3 Fluid 2 4 1 9.98 µM 100 nL 101000

1 A08 1 8 A08 1 8 2 Fluid 1 2 1 50 µM 504 nL 101000

1 A08 1 8 A08 1 8 3 Fluid 2 4 1 30 µM 302 nL 101000

1 A09 1 9 A09 1 9 2 Fluid 1 2 1 50 µM 505 nL 101000

1 A09 1 9 A09 1 9 3 Fluid 2 4 1 50 µM 505 nL 101000

1 A10 1 10 A10 1 10

1 A11 1 11 A11 1 11

1 A12 1 12 A12 1 12

1 B01 2 1 B01 2 1 2 Fluid 1 2 1 100 µM 1010 nL 101000

1 B02 2 2 B02 2 2 2 Fluid 1 2 1 80 µM 808 nL 101000

1 B02 2 2 B02 2 2 4 DMSO normalization6 1 202 nL 101000

1 B03 2 3 B03 2 3 2 Fluid 1 2 1 60 µM 606 nL 101000

1 B03 2 3 B03 2 3 4 DMSO normalization6 1 404 nL 101000

1 B04 2 4 B04 2 4 2 Fluid 1 2 1 40 µM 404 nL 101000

1 B04 2 4 B04 2 4 4 DMSO normalization6 1 606 nL 101000

1 B05 2 5 B05 2 5 2 Fluid 1 2 1 20 µM 202 nL 101000

1 B05 2 5 B05 2 5 4 DMSO normalization6 1 808 nL 101000

1 B06 2 6 B06 2 6 2 Fluid 1 2 1 0.00129 µM 0.013 nL 101000

Plate 

ID Plate

Dispensed

Well

Dispensed

Row

Dispensed

Col

Non-random

Well

Non-random

Row

Non-random

Col Fluid Fluid Name Cassette

Dispense

Head

Dispensed 

Conc/Count Units

Dispensed 

Volume Units

Total Well 

Volume

1 E01 5 1 G06 7 6 3 Fluid 2 1 0.00129 µM 0.013 nL 101000

1 E01 5 1 G06 7 6 4 DMSO normalization6 1 1010 nL 101000

1 E02 5 2 E02 5 2 1 Cells 1 1 1 cell 0.48 nL 100000

1 E03 5 3 G05 7 5 3 Fluid 2 5 1 20 µM 202 nL 101000

1 E03 5 3 G05 7 5 4 DMSO normalization6 1 808 nL 101000

1 E04 5 4 F06 6 6 2 Fluid 1 1 0.00129 µM 0.013 nL 101000

1 E04 5 4 F06 6 6 4 DMSO normalization6 1 1010 nL 101000

1 E05 5 5 E03 5 3 1 Cells 1 1 1 cell 0.48 nL 100000

1 E06 5 6 F03 6 3 2 Fluid 1 3 1 60 µM 606 nL 101000

1 E06 5 6 F03 6 3 4 DMSO normalization6 1 404 nL 101000

1 E07 5 7 E06 5 6 1 Cells 1 1 1 cell 0.48 nL 100000

1 E08 5 8 E08 5 8 2 Fluid 1 3 1 50 µM 504 nL 101000

1 E08 5 8 E08 5 8 3 Fluid 2 5 1 30 µM 302 nL 101000

1 E09 5 9 G08 7 8 2 Fluid 1 3 1 10 µM 100 nL 100000

1 E09 5 9 G08 7 8 3 Fluid 2 5 1 30 µM 301 nL 100000

1 E10 5 10 E10 5 10

1 E11 5 11 E11 5 11

1 E12 5 12 E12 5 12
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Non-random columns provide a tool for re-sorting the dispensing information from a randomized-region of a 
protocol back to the original non-random configuration.  In the example protocol, the wells in region 1 (A1-C9) 
are duplicated in region 5 (E1-G9) and then randomized. Once plate-reader data has been matched to the 
“Dispensed Concentration” or the “Dispensed Volume” columns, then the data can be re-sorted using the 
“NonRandom rows” and “NonRandom col” columns. 

It should be noted that when manually analyzing randomized data, it can often be just as useful to match the 
report file rows to plate reader output rows and then to sort first by fluid name and then by fluid concentration. 

 

Dispensed Conc 

The Dispensed Conc tab shows the dispensed concentration in each well in a spatially-representative plate 
format. This is done first in a composite section, and then in fluid-by-fluid sections. If a well in the composite 
section contains only a single fluid, that well is colored with the color code of that fluid. If a well in the 
composite section contains multiple fluids, the number of fluids dispensed in the well is indicated. If a well was 
requested to have a single cell but the system did not report a single cell in that well, that well does not contain 
an entry for the cell fluid as in wells A1 and A6 below. 

If a protocol contains a single plate, then the tab will be named “1 Dispensed Conc.” If a protocol contains 
multiple plates, then subsequent plates in the protocol will be named with the corresponding plate number, i.e. 
“2 Dispensed Conc,” “3 Dispensed Conc,” etc. 

 

 

 

 

Dispensed Volume 

The Dispensed Volume tab shows the dispensed volume in each well in a spatially-representative plate format. 
This is done first in a composite section and then in fluid-by-fluid sections. If a well in the composite section 
contains only a single fluid, that well is colored with the color code of that fluid. If a well in the composite 

(Composite) 1 2 3 4 5 6 7 8 9

A 1 1 1 1 2 Fluids 2 Fluids 2 Fluids

B 100 80 60 40 20 0.00129 2 Fluids 2 Fluids 2 Fluids

C 100 80 60 40 20 0.00129 2 Fluids 2 Fluids 2 Fluids

D

E 0.00129 1 20 0.00129 1 60 1 2 Fluids 2 Fluids

F 2 Fluids 1 100 40 2 Fluids 20 60 80 2 Fluids

G 100 2 Fluids 2 Fluids 2 Fluids 2 Fluids 40 1 1 80

H

Cells (cell) 1 2 3 4 5 6 7 8 9

A 1 1 1 1

B

C

D

E 1 1 1

F 1

G 1 1

H

Fluid 1 (µM) 1 2 3 4 5 6 7 8 9

A 50 50 50

B 100 80 60 40 20 0.00129 30 30 30

C 9.98 10 9.98

D

E 0.00129 60 50 10

F 50 40 30 20 80 30

G 100 30 10 50 9.98

H
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section contains multiple fluids, then that well is non-colored and contains the cumulative volume of all the 
fluids in the well. If a normalization fluid is used, the total volume reported in the composite section includes 
the volume of the normalization fluid.  

If a protocol contains a single plate, then the tab will be named “1 Dispensed Volume.” If a protocol contains 
multiple plates, then subsequent plates in the protocol will be named with the corresponding plate number, i.e. 
“2 Dispensed Volume,” “3 Dispensed Volume,” etc. 

 

 

Start Time 

The Start Time tab shows the dispense start time for each well in a spatially-representative plate format for 
each plate within a protocol. This is done first in a composite section, and then in fluid-by-fluid sections. If a 
well in the composite section contains only a single fluid, that well is colored with the color code of that fluid. If 
a well in the composite section contains multiple fluids, then that well is non-colored and contains the starting 
dispense time of the first fluid dispensed into that well.  

If a protocol contains a single plate, then the tab will be named “1 Start Time.” If a protocol contains multiple 
plates, then subsequent plates in the protocol will be named with the corresponding plate number, i.e. “2 Start 
Time,” “3 Start Time,” etc. 

 

(Composite) 1 2 3 4 5 6 7 8 9

A 23.2 0.48 0.48 0.48 0.48 9.64 604 806 1010

B 1010 1010 1010 1010 1010 1010 402 603 806

C 1010 1010 1010 1010 1010 1010 200 402 604

D

E 1010 0.48 1010 1010 0.48 1010 0.48 806 402

F 1010 0.48 1010 1010 806 1010 1010 1010 402

G 1010 603 201 604 604 1010 0.48 0.48 1010

H

Cells (nL) 1 2 3 4 5 6 7 8 9

A 23.2 0.48 0.48 0.48 0.48 9.64

B

C

D

E 0.48 0.48 0.48

F 0.48

G 0.48 0.48

H

Fluid 1 (nL) 1 2 3 4 5 6 7 8 9

A 503 504 505

B 1010 808 606 404 202 0.013 301 302 302

C 100 100 100

D

E 0.013 606 504 100

F 505 404 302 202 808 301

G 1010 302 100 503 100

H
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Events 

The Events tab shows key event information for the protocol. This includes, start and finish time for the 
protocol, when plates and cassettes were loaded, when dispense heads were filled with fluid, and when 
dispense heads started and finished dispensing. The starting dispense time per dispense head is shown in 
column A, while the ending dispense time is shown in column B. 

 

 

 

(Composite) 1 2 3 4 5 6 7 8 9

A 15:08:29.1 15:08:29.1 15:08:29.2 15:08:29.2 15:08:29.2 15:08:29.3 15:08:32.9 15:08:32.9 15:08:33.0

B 15:08:32.9 15:08:32.9 15:08:33.2 15:08:33.1 15:08:33.1 15:08:33.1 15:08:33.1 15:08:33.0 15:08:33.0

C 15:08:38.7 15:08:38.8 15:08:38.9 15:08:39.0 15:08:39.0 15:08:39.0 15:08:33.2 15:08:33.2 15:08:33.2

D

E 15:08:39.1 15:08:29.3 15:08:41.6 15:08:33.3 15:08:29.4 15:08:35.9 15:08:29.4 15:08:35.9 15:08:35.9

F 15:08:36.1 15:08:29.5 15:08:41.6 15:08:36.1 15:08:36.0 15:08:36.0 15:08:41.7 15:08:35.9 15:08:36.0

G 15:08:35.8 15:08:36.1 15:08:36.2 15:08:36.2 15:08:36.3 15:08:41.9 15:08:29.5 15:08:29.6 15:08:41.6

H

Cells 1 2 3 4 5 6 7 8 9

A 15:08:29.1 15:08:29.1 15:08:29.2 15:08:29.2 15:08:29.2 15:08:29.3

B

C

D

E 15:08:29.3 15:08:29.4 15:08:29.4

F 15:08:29.5

G 15:08:29.5 15:08:29.6

H

Fluid 1 1 2 3 4 5 6 7 8 9

A 15:08:32.9 15:08:32.9 15:08:33.0

B 15:08:32.9 15:08:32.9 15:08:33.2 15:08:33.1 15:08:33.1 15:08:33.1 15:08:33.1 15:08:33.0 15:08:33.0

C 15:08:33.2 15:08:33.2 15:08:33.2

D

E 15:08:33.3 15:08:35.9 15:08:35.9 15:08:35.9

F 15:08:36.1 15:08:36.1 15:08:36.0 15:08:36.0 15:08:35.9 15:08:36.0

G 15:08:35.8 15:08:36.1 15:08:36.2 15:08:36.2 15:08:36.3

H
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Appendix B–Moving data between the dispensing 
software and other programs 

General copy and paste 

Copying and pasting protocol data within the dispensing software and from the software to the clipboard is 
contextual, with two different modes depending on what is being copied and pasted: 

• Fluid list: Copying and pasting fluids is available by right clicking on the Fluid list or through the Fluids 
section of the Advanced ribbon. 

• Well plate: Copying and pasting wells is available by right clicking within the well plate, through the 
clipboard section of the Home ribbon, and through the global shortcuts (i.e. CTRL-C, CTRL-X, CTRL-V, etc.). 

While this appendix illustrates moving protocol data between the dispensing software and Microsoft Excel, the 
techniques shown can be used to move between the software and other applications as well. 

 

 NOTE: When pasting from Excel, the display format may limit the significant digits for numbers. 

 

Fluid list copy and paste 

 

Below is an illustrative example of a Fluid list with three fluids. This figure uses the “Show More” feature of the 
fluid list (right-click on the list to change). 

 

 

Figure 3 Example fluids list 

 

• Fluid Name:  For red fluid, this is “Fluid 1” 

• Class:  For the blue fluid, this is “Aqueous + Brij 35.” 
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• Stock Concentration and Units: For red fluid, this is 10 mM; for the green fluid, this is 20 µg/mL; for the 
blue fluid there is no stock concentration. 

• Source Plate: For red fluid, this is “Source Plate1” (hover the cursor over fluid to see details). This is the 
optional, user provided, name of the stock compound source plate or vial. 

• Source Well: For red fluid, this is “B17.” This is the optional, user provided, well location within a source 
plate. 

• Dispense by Concentration/Volume: The red and green fluids are dispensed by concentration; the blue 
fluid is dispensed by volume (hover the cursor over the icon to see description).  

• Dispense/No Dispense: For red fluid, this is “Dispense”; for the green fluid, this is “No Dispense” (hover the 
cursor over the icon to see description). A “Dispense” fluid will be dispensed during the running of the 
protocol; a “No Dispense” fluid will not be dispensed.  

Fluid list copy and paste to external application 

Clicking Copy All Fluids will copy all of the contents of the Fluid list to the clipboard. Pasting the information 
from the fluids list in Figure 3 into Microsoft Excel yields the data shown in Figure 4. Each row corresponds to 
one fluid in the Fluid list and the rows are sorted in the order displayed in the Fluid list. Headers are included for 
reference and should not be selected when copying from an external application. 
 

 

Figure 4    Example fluids list pasted into Excel 

Paste fluid information to modify the existing fluid list 

Fluid information can be manipulated in another application and then pasted into the dispenser application 
using the Paste Fluids function on the Advanced ribbon tab. When a fluid name is unchanged, the software 
recognizes the pasted information as an existing fluid and other information associated with that fluid will be 
modified if necessary. For example, pasting the 3x7 array of cells shown in the left portion of Figure 5 yields 
the updated fluids list shown in the right portion of Figure 5. A few details follow: 
 

• If the fluid names being pasted back into the Fluid list match the names already in the Fluid list, and the 
selection region includes other fields of the Fluid list, then these other fields are overwritten with the new 
values. If concentration (and units) or fluid class are blank, however, the existing fluid values will not be 
changed. 

• Specify a fluid as “No dispense” by including any character (any non-blank value) in the No Dispense 
column. 

• Specify a fluid as “Dispense by volume” by including any character (any non-blank value) in the Dispense 
by Volume column. 

 

 

 

 

 

Fluid name

Stock 

conc.

Stock conc. 

units Class Source plate

Source 

well No Dispense

Dispense 

by Volume

Fluid 1 10 mM DMSO Source Plate1 B17

Fluid 2 20 µg/mL DMSO Mother Plate G11 No Dispense

Fluid 3 a+B Daughter Plate E9 By Volume
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Figure 5  Example Fluid list pasted back into dispensing software with fluid details modified 

 
Since the fluid list was modified, the user is warned before Paste Fluids is completed. 
 

 

 
TIP:  Do not select column headings when pasting fluids from Excel. 

 

Paste new fluids 

When using the Paste fluid function, if a fluid has a name that is not already contained in the Fluid list, the 
software interprets the pasted information as belonging to a new fluid. In this case, the information associated 
with the new fluid is appended to the Fluid list.  Pasting the 3x7 array of cells shown in the left portion of Figure 
6 yields the updated Fluid list shown in the right portion of Figure 6.  

 

Figure 6  Example of new fluids pasted into the dispensing software, appended to the Fluid list 

 

Fluid 1 10 mM DMSO Source Plate1 B17 x

Fluid 2 32 µg/mL DMSO

Fluid 3

circle 10 mM DMSO Source Plate1 B17 x

square 32 µg/mL DMSO

triangle
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Replace existing fluids 

When a protocol is repeatedly used as a template, and only the fluids are changing between protocol runs, the 
fluids can be changed using the Replace fluids function. This allows fluid information to be replaced without 
modifying any well fluids associated with the fluids already in the Fluid list. When starting with the Fluid list on 
the left portion of Figure 7, copying the 2x1 array of cells shown in the center portion of Figure 7 and using the 
Replace fluids function yields the Fluid list shown on the right portion of Figure 7.  
 

Figure 7 Original Fluid list [left], copy region with new fluid names [center], and resulting Fluid list after 

using Replace fluid function [right] 

 

Well plate copy and paste 

 

Below is an illustrative example of a well plate grid from a protocol. This protocol is used as a starting point for 
the following examples: 

circle

square
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Copy wells to external application 

Clicking Copy Wells will copy the contents of the selected wells to the clipboard. Pasting this information into 
Microsoft Excel yields data like that shown in Figure 8. For each fluid in the plate, a representative well plate 
template with column and row headers is created. For fluids dispensed by volume, the values pasted in each 
cell within the template correspond to the volume of the respective fluid in current protocol units. For fluids 
dispensed by Concentration, the values pasted in each cell within the template correspond to the concentration 
of the respective fluid in current protocol units. In the row above each fluid template is information for that 
fluid, specifically (from left to right): Fluid name, Stock Concentration and Units, Class, Source Plate, Source 
Well, No Dispense, and Dispense Mode. A few additional details follow: 
 

• Copy Wells does not function when viewing randomized. 

• Normalization information will not be copied or pasted to an external application (e.g. Microsoft Excel). 

• Randomization information is not copied to the clipboard. 

• Copy Wells only copies the selected wells – it does not copy all the well contents of the plate (Copy All 
Wells copies all the well contents of the plate)  

 

Figure 8   Output of Copy Wells function after pasting into Microsoft Excel 

 

Fluid 1 10 mM DMSO First Source PlateE7

µM 1 2 3 4 5 6 7 8 9 10 11 12

A 100 10.53874 1.11065 0.117049 0.012335 0.0013 30 0.197484 0.0013 30 0.197484 0.0013

B 30 0.197484 0.0013 30 0.197484 0.0013

C 30 0.197484 0.0013 30 0.197484 0.0013

D

E 100 10.53874 1.11065 0.117049 0.012335 0.0013 30 0.197484 0.0013 30 0.197484 0.0013

F 30 0.197484 0.0013 30 0.197484 0.0013

G 30 0.197484 0.0013 30 0.197484 0.0013

H

Fluid 2 10 mM DMSO Second Source PlateG11 By Volume

nL 1 2 3 4 5 6 7 8 9 10 11 12

A 300 300 300 300 300 300

B 1000 105.3874 11.1065 1.170485 0.123354 0.013 1.974842 1.974842 1.974842 1.974842 1.974842 1.974842

C 0.013 0.013 0.013 0.013 0.013 0.013

D

E 300 300 300 300 300 300

F 1000 105.3874 11.1065 1.170485 0.123354 0.013 1.974842 1.974842 1.974842 1.974842 1.974842 1.974842

G 0.013 0.013 0.013 0.013 0.013 0.013

H

Fluid 3 20 µg/mL DMSO

ng/mL 1 2 3 4 5 6 7 8 9 10 11 12

A 50 50 50

B 50 50 50

C 200 21.07748 2.221301 0.234097 0.024671 0.0026 50 50 50

D 200

E 50 50 50

F 50 50 50

G 200 21.07748 2.221301 0.234097 0.024671 0.0026 50 50 50

H
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Paste structured well information 

Well information can be manipulated in Microsoft Excel and then pasted into the dispensing software using the 
Paste function. Values in each cell are interpreted using the units in the upper-left corner of the fluid headers. 
The units may be concentration or volume units. 

 

 
NOTE: To paste raw concentration or volume values, see the Paste unstructured well information 
section. 

 

A few additional details: 

• If the entire well plate template region is copied from Microsoft Excel onto the clipboard, including the 
fluid header row above each fluid region, then the Paste function in the software recognizes the template 
as being a plate and displays the following messages: 

 

 

• If Replace all fluids in the plate is checked, then all existing well contents on the plate are deleted and 
replaced with the new well values 

• If Replace all fluids in the plate is unchecked, then existing well contents on the plate for fluids in the 
clipboard are replaced, but existing well contents for fluids not on the clipboard remain. In this case, if a 
well already contains Fluid 1, for example, and the paste region for that well contains Fluid 8, the resulting 
well will contain both Fluid 1 and Fluid 8. 

• If only a portion of a well plate is selected when copying from Microsoft Excel, then only the wells within 
the selected region will be written upon pasting into the software. Wells outside of the selected region will 
not be overwritten. For example, if only the upper 5x3 grid of wells from the example protocol shown in 
the left half of Figure 9 are pasted back into the protocol onto a blank plate, then the message shown in 
the right half of Figure 9 is shown. The final message shown in the bottom half of Figure 9 warns users 
that existing fluids in the plate area will be overwritten. 

 

 

 

Fluid 1 10 mM DMSO

µM 1 2 3

A 100 10.53874 1.11065

B

C

D

E 100 10.53874 1.11065
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Figure 9      Paste a partial plate 

 

Clicking continue yields the plate shown below: 

 

• Only the fluid name is required in the row above the template header, all other fluid information is 
optional. 

• Changing the fluid information in the row above the template header will modify the values in the Fluid 
list. Empty cells in the fluid-information row will be ignored. 

 

 
NOTE:  Empty fluid information cells are treated differently than they are when pasting into the Fluid 
list (Paste fluid information to modify the existing fluid list). 

 

Modify well information example 

In this example, the original data in Figure 8 has been modified as shown in Figure 10. Rows of Fluid 1 and Fluid 
2 have been swapped in columns 1-6. In addition, another copy of the Fluid 1 columns 1-6 has been added to 
row H.  Only Fluids 1 and 2 (not Fluid 3) are copied to the clipboard and pasted into the dispensing software. 
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Figure 10         Modified Data in Microsoft Excel 

 

Figure 11 shows the result in the dispensing software, with the original plate in the left portion of the figure, 
and the modified plate in the right portion of the figure.  In addition to seeing that the red and green fluids 
within columns 1-6 have changed places, it can be seen that the original randomization definitions are 
unchanged, and the normalization and blue fluids have been eliminated. 
 

Figure 11       Original and then modified plate in dispensing software 

 

Paste unstructured well information 

Well information can be created directly in Microsoft Excel without template information and then pasted into 
the dispensing software using the Paste function.  When unstructured well information is pasted, the user will 
be prompted by the software to identify what fluid to associate with the pasted wells. Pasting will be done in 
current mode and units for the selected fluid.  

In this example, the following array of values is created in Microsoft Excel and copied to the clipboard: 

 

Fluid 1 10 mM DMSO First Source PlateE7

µM 1 2 3 4 5 6 7 8 9 10 11 12

A 30 0.197484 0.0013 30 0.197484 0.0013

B 100 10.53874 1.11065 0.117049 0.012335 0.0013 30 0.197484 0.0013 30 0.197484 0.0013

C 30 0.197484 0.0013 30 0.197484 0.0013

D

E 30 0.197484 0.0013 30 0.197484 0.0013

F 100 10.53874 1.11065 0.117049 0.012335 0.0013 30 0.197484 0.0013 30 0.197484 0.0013

G 30 0.197484 0.0013 30 0.197484 0.0013

H 100 10.53874 1.11065 0.117049 0.012335 0.0013

Fluid 2 10 mM DMSO Second Source PlateG11 By Volume

nL 1 2 3 4 5 6 7 8 9 10 11 12

A 1000 105.3874 11.1065 1.170485 0.123354 0.013 300 300 300 300 300 300

B 1.974842 1.974842 1.974842 1.974842 1.974842 1.974842

C 0.013 0.013 0.013 0.013 0.013 0.013

D

E 1000 105.3874 11.1065 1.170485 0.123354 0.013 300 300 300 300 300 300

F 1.974842 1.974842 1.974842 1.974842 1.974842 1.974842

G 0.013 0.013 0.013 0.013 0.013 0.013

H
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When a destination location is selected within a well plate in the Main Operating Window and either Paste or 
Paste Special is selected, the software will respond with the following prompt and the user must select a fluid 
from the drop-down list to paste. 

 

 

• If Replace all fluids in the paste region is checked, then all existing well contents are replaced with the new 
well values in the paste region. 

• If Transpose rows and columns is checked, the rows and columns are transposed during paste. 

If no fluids exist within the Fluid list, pasting of unstructured well information is not allowed. In this example, 
well B2 is identified as the destination location, and Fluid 1 is identified as the Paste Fluid. Figure 12 shows the 
result in the protocol. 

 

Figure 12    Result of pasting in the example unstructured data into well B2 with Fluid 1 selected. 

100 50 20 10

5 2 1 0.5

0.2 0.1 0.05 0
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Appendix C–Matching randomized layout to plate 
reader data 

Once a randomized protocol has been created and run on the dispenser, the dispensing profile needs to be 
joined with corresponding plate-reader data for analysis. The following shows an example of this procedure. 

 

 
TIP: The Data Merge utility, included in the dispensing software install package, can more easily be 
used to combine plate reader CSV data with dispense data from an HP report file. 

 

Step 1: Create and run a randomized protocol 

Figure 13 shows a typical titration protocol before and after it has been randomized. The randomized protocol 
is run on the dispenser and the resultant plates are read on a plate reader. 

  

Figure 13 Original Non-Randomized Protocol [left]; Randomized Protocol [right] 

 

 

NOTE: This example assumes that empty wells are included in the “Tabular Detail” tab of the 
report (see Reports). Alternately, the “Tabular” report tab could be used. 
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Step 2: Read results on plate reader 

Figure 14 shows typical results from a plate reader. When a plate reader has the option, it is preferable to use 
columnar output format, in other words with data sorted A1-H12 (96 plate) or A1-P24 (384 plate) in a single 
column. Save the plate reader data to an Excel or CSV file for use in Step 4. 

 

Figure 14 Typical plate reader output in columnar format 

 

Step 3: Open the dispenser *.xml report file in Excel 

Once the *.xml report file has been opened, go to the “Tabular Detail” tab to find the dispense data arranged 
with each dispense assigned to a row. Note that rows are ordered A1 -H12 (96 plate) or A1-P24 (384 plate) and 
that in the example below, the dispensed volumes are found in Column ‘P’, while the corresponding 
concentrations are found in Column ‘N’. 

 

Figure 15       Dispense data Tabular-Detail Tab 
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Step 4: Paste reader data into the *.xml file. 

Paste the plate reader data into the “Tabular Detail” tab of the *.xml dispenser report file. Because both data 
sets are ordered A1-H12, the plate reader wells are now matched with the report file wells. The pasted wells 
are highlighted in yellow for visibility. 

 

Figure 16        Dispense data with plate reader data pasted in 

 

Step 5: Re-sort data by fluid name and then “Dispensed concentration” 

To get the data sorted by fluid name and then in order of concentration, the Excel ‘data sort’ function can be 
employed, as shown in Figure 17. The resultant data after sorting can be seen in Figure 18. 

 

Figure 17 Data sort function in Excel to get randomized data into a useful sequence 
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Figure 18      Data set now sorted by Fluid name and then by dispensed concentration 

 

Getting plate reader data into columnar format 

If plate reader data is output in spatial plate-layout format, rather than columnar format, several templates are 
available to enable the conversion to columnar format: 

• Spatial Plate to Columnar Template 96:  For analyzing 96-well plates. 

• Spatial Plate to Columnar Template 384:  For analyzing 384-well plates. 

• Spatial Plate to Columnar Template 1536:  For analyzing 1536-well plates. 

These templates are found in the HP Dispensing folder within “My Documents.” Each template has an “Input 
SpatialFormat *” tab, and an “Output ColumnarFormat *” tab. Reader data in spatial plate-layout format can be 
pasted into the Input tab, and then the same plate data in columnar format can be copied out of the output tab. 
Figure 19 shows an example of a 384-plate template for inputting spatial plate-layout data. Figure 20 shows 
an example of the same data in columnar output format. Once data is arranged in columnar format, it can then 
be matched to the dispenser report file as shown below. 

 

Figure 19   Sample data input in spatial-plate format 
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Figure 20 Sample data output in columnar format 

Alternative methods for sorting 

Note in Figure 18 that several other columns may sometimes be useful as an alternative method for sorting 
dispensing data after it has been paired to plate-reader data. Specifically, Columns F (Non-Random well), 
Column G (Non-Random Row), and/or Column H (Non-Random Column) can be used to rearrange randomized 
plate dispense and plate reader data back into the original non-randomized layout.  
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Appendix D–Concentration calculations 

With DMSO and dilute aqueous solutions, volume to achieve a desired concentration may be calculated without 
including dispensed volumes; this is a negligible error since the added volumes from the dispenser are small 
relative to the total assay volume. However, there are cases where the entire assay may be dispensed by the 
dispenser. For example, in miniaturized well plate based PCR, the volumes added by the dispenser are usually 
significant and should not be ignored in concentration calculations. 

Each protocol plate has a specified additional volume. This additional volume is the amount of fluid that the 
user places in the well in addition to dispensed fluids. The total assay volume will be this additional volume plus 
volume dispensed by the dispenser. In some cases – such as miniaturized PCR where master mix, primer and 
sample are all from the dispenser – the additional volume for the plate should be set to zero. 

Calculation of true concentration must be accomplished iteratively since adding fluid with the dispenser 
changes the overall assay volume which in turn changes concentrations. Calculation of concentration utilizes 
well volumes that include both dispensed fluids and user-added Additional volume (see Plate-associated 
information). 

 

 

NOTE: Prior to software release 3.2, concentrations were calculated without including the volume 
dispensed using the dispenser. This change in concentration calculation means that reported 
concentrations from earlier versions of the software may be slightly different than those currently 
reported.  This difference is generally negligible relative to other errors in the assay workflow. 

 

Since concentrations are calculated iteratively, there can be conditions created where concentrations cannot be 
calculated. For example, it is possible to Normalize wells using Normalize to % of total volume with a 
percentage high enough where a solution does not exist as concentrations are iteratively recalculated. If this 
occurs, a warning is displayed for affected wells. 
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Appendix E–Dispense specifications 

DMSO dispensing 

Selected dispense head cassette specifications for DMSO dispensing: 

• 70-100% DMSO. 

• Nanoparticles < 1 micron in diameter in stable suspension at concentrations ≤ 0.5%. 

• There are additional considerations for small molecule and biomolecule dispensing. See Dispensing 
considerations for more information. 

• Only use non-Surfactant-Free cassettes for DMSO dispensing. 

 Standard-volume cassette High-volume cassette 

Maximum dispense volume 
per dispense head 

10 µL 200 µL 

Maximum dispense volume 
per dispense head – 

normalization and bulk dispense 1 
20 µL 200 µL 

Minimum dispense volume 13 pL 1 nL 

Minimum dispense volume – 
normalization and bulk dispense 1 

1 nL 1 nL 

Minimum fill volume 2 µL 50 µL 

Maximum dispense volume – 
each fluid per well 

10 µL 10 µL 

Dispense increment (per well) 
400 pL for > 3.6 nL 

20 pL for 17 pL - 3.6 nL 
13 pL for < 17 pL 

400 pL for > 3.6 nL 
20 pL for 1 - 3.6 nL 

n/a for < 1 nL 

Protocol limits (per fluid) 32 plates 32 plates 

 

Notes: 

1 – Bulk Dispense is defined as when all dispensed volumes for a fluid are 1nL or greater. 

 

Acetonitrile (ACN) dispensing 

Selected dispense head cassette specifications for ACN dispensing: 

• Dispensing of ACN is limited to one 384-well plate per dispense head due to its rapid evaporation rate. 

• Recommended use of standard volume cassettes due to the rapid evaporation rate of ACN. 

• Dispense volume is limited to >10 nL per well and <40 µL per fluid per protocol. 

• For combined use with TMTs a maximum concentration of 85 mM TMT is recommended. 

• There are additional considerations for small molecule and biomolecule dispensing. See Dispensing 
considerations for more information. 

• Only use non-Surfactant-Free cassettes for ACN dispensing.   
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Aqueous dispensing 

Selected dispense head cassette specifications for aqueous dispensing, including surfactant and glycerol: 

• Aqueous solutions require the addition of surfactant to enable priming by reducing surface tension unless 
using Surfactant-Free cassettes. Refer to Table 1 for recommended surfactants and concentration 
ranges. In addition, the presence or absence of glycerol impacts dispensing – there are separate fluid 
classes dependent on glycerol content.  

• Master mix fluids (Table 2) do not require addition of surfactants and should not be dispensed with 
Surfactant-Free (SF) cassettes. 

• Aqueous compounds can be dispensed without the addition of surfactant using Surfactant-Free (SF) 
cassettes. 

• Total buffer components < 150 mM. 

• Nanoparticles < 1 micron in diameter in stable suspension at concentrations ≤ 0.5% by weight. 

• Types of biomolecules which either can or cannot be dispensed are listed in Table 3. 

• There are additional considerations for small molecule and biomolecule dispensing. See Dispensing 
considerations for more information. 

 Standard-volume cassette High-volume cassette 

Maximum dispense volume 
per dispense head 

10 µL 200 µL 

Maximum dispense volume 
per dispense head – 

normalization and bulk dispense 1 
20 µL 200 µL 

Minimum dispense volume 11 pL 1 nL 

Minimum dispense volume – 
normalization and bulk dispense 1 

1 nL 1 nL 

Minimum fill volume 4 µL 50 µL 

Maximum dispense volume – 
each fluid per well 

10 µL 10 µL 

Dispense increment (per well) 
without glycerol 

560 pL for > 3.6 nL 
11 pL for ≤ 3.6 nL 

 

560 pL for > 3.6 nL 
11 pL for 1 - 3.6 nL 

n/a for < 1 nL 

Dispense increment (per well) 
with glycerol 

600 pL for > 3.6 nL 
12 pL for ≤ 3.6 nL 

 

600 pL for > 3.6 nL 
12 pL for 1 - 3.6 nL 

n/a for < 1 nL 

Protocol limits (per fluid) 1536 wells or 8 plates 2, 3 1536 wells or 8 plates 2, 3 

 

Notes: 

1 – Bulk Dispense is defined as when all dispensed volumes for a fluid are 1nL or greater. 

2 – To minimize evaporation. 

3 – Except Aqueous fluids listed in Table 4 that have a protocol limit of 1 plate (384-well) 
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Fluid Class Surfactant 
Surfactant 

Concentration 
Glycerol 

Aqueous None N/A 0 - <5% 

a + B Brij 35 0.1 % 0 - <5% 

a + B + g Brij 35 0.1 % 5 - 20% 

a + TX Triton X100 0.1 % 0 - <5% 

a + TX + g Triton X100 0.1 % 5 - 20% 

a + Tw Tween 20 0.3% 0 - <5% 

a + Tw + g Tween 20 0.3% 5 - 20% 

Table 1. Aqueous fluid classes 

 

Master Mixes1 

Brilliant II SYBR Green qRT-PCR 1-Step Master Mix 
Brilliant III Ultra-Fast SYBR Green qPCR Master Mix 

Brilliant Multiplex qPCR Master Mix 
Fast SYBR Green Master Mix 

iQ SYBR Green Supermix 
Power SYBR Green PCR Master Mix 
PowerUp SYBR Green Master Mix 

QuantiTect SYBR Green PCR Master Mix 
SsoAdvanced Universal SYBR Green Supermix 

SYBR Select Master Mix 
TaqMan Gene Expression Master Mix 

TaqMan RNA-to-CT 1-Step Kit 
TaqMan Universal PCR Master Mix 

Table 2. Master Mixes 

 

Notes: 

1 – The system requires some preparation time to dispense a master mix to ensure optimal performance in every well.  The 
length of this delay may vary from one master mix to another. 

 

Compatible Not Compatible 

Enzymes < 300kDa 
Antibodies 
Peptides 

Oligos and labeled oligos 
Lipids 

Small molecules such as ATP, ADP 
PCR Master mix 

DNA < 10,000 base pairs 

Enzymes > 300kDa 
Saliva 

Whole blood 
Plasma 
Serum 

Table 3. Example compatible biomolecules 

 



 

 Dispensing Software 116 

 

Chemical name 
Maximum 

concentration 

Recommended 
dispense volume 

(per well) 

Recommended 
cassette 

Protocol limits 
(per fluid) 

Iodoacetamide (IAA) 53 mM 11 pl - 2.5 µL High and standard 
volume SF 

1 384-well plate 

Tris(2-
carboxyethyl)phosphine 

(TCEP) 

100 mM 11 pl - 2.5 µL High and standard 
volume SF 

1 384-well plate 

Dithiothreitol (DTT) 50 mM 11 pl - 2.5 µL High and standard 
volume SF 

1 384-well plate 

Trypsin 0.1 mg/mL 11 pl - 2.5 µL High and standard 
volume SF 

1 384-well plate 

Triethylammonium 
bicarbonate (TEAB) 

100 mM 11 p l- 2.5 µL High and standard 
volume SF 

1 384-well plate 

Trifluoroacetic acid 
(TFA)1 

10% aq 10 nL - 2.5 µL1 High and standard 
volume SF 

1 384-well plate 

Hydroxylamine  5% aq 11 p l- 2.5 µL High and standard 
volume SF 

1 384-well plate 

Formic Acid 4% aq 11 p l- 2.5 µL High and standard 
volume SF 

1 384-well plate 

Table 4. Proteomics fluids qualified for aqueous dispensing using Surfactant-Free (SF) cassettes 

 

Notes: 

1 –Recommended TFA dispense volume range between 10 nL and 2.5 µL based on internal testing 
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Single cell dispensing 

Selected dispense head cassette specifications for single cell dispensing: 

• Cells suspended in 1X PBS buffer at 200 cells/µL. 

• Cell size range 10 – 25 µm. 

• There are additional considerations for cell dispensing. See Appendix F–Best practices for dispensing - 
Single cell dispensing for more detail. 

 

 Single cell cassette 

Maximum dispense volume 
per dispense head 

20 µL 

Minimum single cell isolation 
volume 

480 pL 

Minimum fill volume 4 µL 

Drop volume 40 pl 

Protocol cassette limit 384 wells or 1 plate  

 

Fluid group Fluid class 
Recommended cell size 

range 

Cells Small 10 – 14 µm 

Cells Medium 15 – 17 µm 

Cells Large 18 – 20 µm 

Cells Extra Large 21 – 25 µm 

Sticky Cells Small 10 – 14 µm 

Sticky Cells Medium 15 – 17 µm 

Sticky Cells Large 18 – 20 µm 

Sticky Cells Extra Large 21– 25 µm 

Table 5. Cell fluid groups and classes 

Fluid group selection 

• Cells: this fluid group refers to most standard cell lines. 

• Sticky cells: this fluid group refers to cell lines that tend to aggregate after trypsinization in suspension. 
Sticky cells require a larger clearing volume to travel through the microfluidics and to be dispensed into 
the target well. 
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Fluid class selection 

• The cell size is the diameter of the rounded cells in suspension.  

Compatible cell types: 

Compatible (10-25 µm cell sizes) Not compatible 

Adherent cell lines 
Suspension cell lines 

Disaggregated cell constructs 
Disaggregated organoids 

Primary cells 

Bacteria 
Cell organelles (e.g. nuclei) 

Yeast 
Virus 

 

 

Dispensing considerations 

The dispensing software will use one of several modes to dispense your fluids.  If you have high-volume 
cassettes available, there are three potential modes.  

• Use high-volume cassettes with a maximum dispense volume of 200 µL.   

• Use standard-volume cassettes with a maximum dispense volume of 20 µL. 

• Use standard-volume cassettes with a maximum dispense volume of 10 µL. 

In deciding which mode will be used, the first consideration is the lowest volume to be dispensed into any well 
using that fluid.  If any well has less than one nL, then standard-volume cassettes dispensing 10 µL will be used 
to ensure good reproducibility with low volume dispensing.  If all wells for a fluid are greater than one nL, then 
Table 6 should be used.  The more concentrated the fluid, the less total volume can be reliably dispensed.  If 
the DMSO fluid class is used, or if the biomolecule concentration is not entered in mg/mL, then the most 
economical option is used by the dispenser. 

 

 Small Molecules Biomolecules 

Standard-volume 10 µL 
1000 Da 
10 mM 

300 kDa or 10,000 base pairs 
3 mg/mL 

Standard-volume 20 µL 
1000 Da 
10 mM 

300 kDa or 10,000 base pairs 
1 mg/mL 

High-volume 200 µL 
1000 Da 
10 mM 

300 kDa or 10,000 base pairs 
0.3 mg/mL 

Table 6. Dispense limits for small molecules and biomolecules 

 

One final consideration is that high-volume cassettes have a greater dead volume than standard-volume 
cassettes due to the amount of stranded fluid in the large fill cup. If there is an extremely precious fluid, 
deselect “Use high-volume cassettes” at the start of the protocol run. 
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Appendix F–Best practices for dispensing 

All fluids 

To ensure optimum performance, it is recommended that the first plate using a fluid includes a well with 
volume of 30 nL or greater; this ensures the dispense head is fully ready to dispense other much smaller 
volumes.  Since plate dispense order can vary, it is recommended that all plates follow this recommendation. If 
your assay design cannot tolerate a dispense volume greater than 30nL, consider dedicating one “scrap” well 
on each plate to a larger dispense volume.  This same well can be used for all fluids on the plate. 

DMSO based fluids 

• Although very large numbers of fluids and plates are allowed, it is recommended that designs of fewer 
than 100 fluids and 32 plates are used to reduce user error and to speed up the display processes of the 
software. 

• DMSO fluids with only small molecules less than 1000 Daltons at concentrations no more than 10mM are 
recommended to be dispensed with the dispenser. 

• If prefilling the dispense heads with fluids outside of the dispenser, for example using a robotic system, 
minimize the time between filling and dispensing.  It is recommended that prefilled dispense heads with 
DMSO based fluids be used within 30 minutes of filling. 

• During the Run Protocol operation, it is recommended that the dispenser not be paused for longer than 15 
minutes prior to resuming while using DMSO based fluids. 

• Only use non-Surfactant-Free cassettes for DMSO dispensing. 

Acetonitrile (ACN) based fluids 

• ACN fluids with only small molecules less than 1000 Daltons at concentrations no more than 10mM are 
recommended to be dispensed (except for TMTs, tested to 85 mM) 

• Do not prefill the dispense heads with ACN fluids due to evaporation concerns 

• During the Run Protocol operation, it is recommended that the dispenser not be paused while using ACN 
based fluids. 

• Shaking after each dispense head is not recommended for ACN fluids.   

• Only use non-Surfactant-Free cassettes for ACN dispensing. 

• Due to the high evaporation rate of ACN, a limitation of one 384-well plate per dispense head  is 
recommended.  

Aqueous based fluids 

• The recommended limits for aqueous based fluids are shown when the cursor is moved over the Fluid 
Class drop-down menu in the Fluid Edit dialog box.  For all aqueous fluids it is recommended that: 

o Small molecule compounds be less than 1000 Daltons and be present at no more than 10mM 
concentration, except for selected Proteomics reagents (see Appendix E–Dispense specifications, 
Table 4). 

o Biomolecules be less than 300kD and be present in total at no more than 3mg/mL concentration. 

o Glycerol levels be within the fluid class guidelines of either 0 - <5% or 5 - 20%. 

• Surfactant-Free (SF) cassettes should be stored at 4ºC to maintain 6-month shelf life. 
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• The best practices noted below are due to the high evaporation rate of aqueous fluids relative to DMSO: 

o The maximum number of plates in an aqueous fluid protocol is 1536 wells or 8 plates (or 1 plate for 
proteomics fluids, see Appendix E–Dispense specifications, Table 4). 

o The amount of aqueous fluid that the user is requested to add to each dispense head is greater than 
that requested for DMSO fluids, even when the amount to be dispensed is the same.  In addition, the 
minimum volume requested for the fill is 4 µL for aqueous fluids as opposed to a 2 µL minimum 
requested volume for DMSO fluids.  The dispensed volume for each fluid in the protocol is listed in 
the Fluids List, and the amount to fill into the dispense head is given during Run Protocol.    

o Fill dispense heads with only the amount of aqueous fluid requested at the time of use during Run 
Protocol.  It is not recommended to overfill aqueous fluids in any dispense head. 

o Fill dispense heads with aqueous fluids at the time of use during Run Protocol.  It is recommended 
that dispense heads not be prefilled offline with aqueous based fluids. 

o During the Run Protocol operation, it is recommended that the dispenser not be paused while using 
aqueous based fluids. 

o Shaking after each dispense head is not recommended for aqueous fluids.   

Single cell dispensing 

• For all cell dispensing users must: 

o Use a C1 single cell cassette (limited to 384 wells each to ensure performance). 

Recommended single cell sample preparation protocol 

• Use cell culture at about 80% confluence pre-dispensing. 

• Wash cells with 1X PBS three times before trypsinization. 

• Trypsinize and neutralize with complete medium. 

• Pipette cell suspension 10 times up and down. 

• Take a 1 mL aliquot of the cell suspension and test cell concentration and viability.  

• Centrifuge cell suspension at 200 rcf for five minutes. 

• Discard supernatant and resuspend cell pellet in 1 mL 1X PBS.  

• Filter the cell suspension with a 35 µm filter to form the stock cell suspension.  

• Test cell concentration and viability. 

• Begin a single cell protocol run on the D100 up to the point of inserting the C1 cassette. 

• Dilute stock cell suspension sample with 1X PBS to 200 cells/µL to form the dispensing cell suspension. 

• Immediately load the fill cup of the single cell C1 cassette with the dispensing cell suspension without 
introducing bubbles and initiate dispensing run. 

Other recommendations 

• Keep stock cell suspension at room temperature.  

• Prepare a fresh dispensing cell suspension if not used within 10 minutes.  

• Measure cell concentration and viability of the stock cell suspension again to guarantee accurate dilution. 

• Vortex (~ three seconds) before loading cell suspension into the single cell dispensing cassette. 
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• Vortex the dispensing cell suspension frequently (every three minutes) while not being used. 

• For microscopy imaging purposes, pre-fill plates with low volume of fluid (15 µl recommended for 384-
well plates) for optimal post-dispense analysis of accuracy. 

Cell fluid group and class 

Choose the cell fluid group and class that generate the most single cell wells and least non-single cell wells as 
confirmed by microscopy or other technique such as proteomics or qPCR.  

• Choosing the wrong cell fluid group can lead to: 

o More non-single cell wells by selecting Sticky Cells when working with non-sticky cells  

o False positive single cell wells (non-single cell well reported as single cell well) when working with a 
sticky cell line and selecting the Cells fluid group. 

• Choosing the wrong cell fluid class can lead to the following problems: 

o If fluid class is too small, cells will clog the cassette and cause a time out error. There may also be an 
increase in false positive single cell wells (more wells containing 0 cells will be reported as containing a 
single cell). 

o If fluid class is too large there may be an Increase in false positive single cell wells (more wells 
containing multiple cells will be reported as containing a single cell). 

Time-out 

• Poor single cell sample preparation: prepare a fresh dispensing cell suspension (ensure thorough 
pipetting to disaggregate cell clumps), replace cassette and continue single cell dispensing. Stock cell 
suspension might need to be prepared de novo if error persists. 

• Wrong cell concentration: prepare a fresh dispensing cell suspension by re-diluting the stock cell 
suspension to 200 cells/µL in 1X PBS. 

• Wrong fluid class selection: 

o Test the fluid class that best matches the dispensed cell size according to the cell size range 
recommendations listed in Appendix E–Dispense specifications, Table 4. 

o Choose the right fluid group depending on the dispensed cell properties. For each test, it is 
recommended to confirm single cell dispensing accuracy using microscopy or other technique to 
evaluate positive/false negatives. 

C1 single cell cassettes 

• Do not exceed cassette shelf-life specification: it is not recommended to use C1 cassettes beyond the 
expiration date. 

• It is recommended to refrigerate the C1 cassettes at 4ºC to ensure adequate shelf life. 
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Deep well plates 

As distance between the dispense cassette and the target surface increases, dispense placement variation also 
increases. For this reason, it is best to minimize the dispense distance. When dispensing into deep well plates, it 
is recommended to dispense into pre-filled plates. 

 

  

Best practice Not optimal 
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